PanelMate® ePro
Users Guide
Support Services

The goal of Advanced Technology Services business unit is to ensure your greatest possible satisfaction with the operation of our products. We are dedicated to providing fast, friendly and accurate assistance. That is why we offer you so many ways to get the support you need. Whether it's by phone, fax or e-mail, you can access Advanced Technology Services support information 24 hours a day, seven days a week. Our wide range of services are listed below.

You should contact your local distributor for product pricing, availability, ordering, expediting and repairs.

Website

Website Address       www.buypanelmate.com  800.328.7287
# Table of Contents

**Preface** ........................................................................................................................................................................... 2

**Support Services** ................................................................................................................................................................. 3
- Website .................................................................................................................................................................................. 3
- e-COM Support Center .......................................................................................................................................................... 3
- e-TRC Technical Resource Center ...................................................................................................................................... 3
- European PanelMate Support Center ................................................................................................................................... 4
- Information Fax-Back Service For Legacy Products ........................................................................................................... 4
- Repair and Upgrade Service.................................................................................................................................................... 4

**Table of Contents** .................................................................................................................................................................. 5

**Chapter 1: Introduction** ......................................................................................................................................................... 10
- PanelMate ePro ........................................................................................................................................................................ 11
  - What Does the “e” in ePro Represent? .................................................................................................................................. 11
  - ePro Models ........................................................................................................................................................................... 11
  - ePro Technical Details ........................................................................................................................................................... 13
  - Windows NT Embedded (NTE) ............................................................................................................................................. 13

**Chapter 2: Getting Started With Your ePro Unit** .................................................................................................................. 15
- Powering Up Your ePro Unit ....................................................................................................................................................... 16
  - Power and Ground Instructions ................................................................................................................................................ 16
  - First Time Power Up Process .................................................................................................................................................. 17
  - Closing the ePro Demo ............................................................................................................................................................ 18
- Preparing Your ePro Unit for Online Use ............................................................................................................................... 18
  - Communicating to a PLC or Controller ................................................................................................................................ 19
- Preparing Your ePro for Data Transfer/Software Downloads .............................................................................................. 20
  - Preparing Your ePro for Data Transfer/Software Downloads ................................................................................................ 21
    - Connecting to Your ePro Via the Ethernet .......................................................................................................................... 21
    - Connecting to the ePro Using an M-System DiskonKey Device .......................................................................................... 25
    - Connecting to the ePro Using an Iomega USB Device ....................................................................................................... 26
Connecting Windows 98 PCs to an ePro ............................................................ 27
Connecting Windows ME PC’s to an ePro ............................................................ 30
Installing Software and Downloading Configurations ........................................ 30
C/D Partitions ...................................................................................................... 30
Types of Software That Can Be Installed ............................................................. 31
Installing Software ............................................................................................... 31
Downloading a Configuration (.pps File) ............................................................... 33
Uninstalling Software .......................................................................................... 33
Managing Accounts and Changing Passwords ................................................... 35
Modifying the Administrator Account Name and Password .............................. 35
Using the Auto Logon Feature ............................................................................ 35

Chapter 3: Launching a PanelMate PC PRO Configuration_____________ 38
Launching Methods ............................................................................................... 39
Using the Startup PMStart.cmd File to Launch a Configuration .......................... 39
Using the Start>Run Command .......................................................................... 40
Power-Up Sequence ............................................................................................... 40
Run Mode ............................................................................................................. 40

Chapter 4: Protecting Your ePro Operating System and Runtime Files __ 43
Placing Your ePro Unit in Protect Mode ............................................................... 44
Placing Your ePro Unit in Normal Mode ............................................................... 44
Checking the Protect Mode/Normal Mode Status ................................................. 44

Chapter 5: Run Mode Operations__________________________________ 45
Touchscreen Units and Run Mode ...................................................................... 46
TouchPanel Units and Run Mode ....................................................................... 46
Run Mode ............................................................................................................ 48

Online Page Layout................................................................................................. 49
Page Number and Page Title .............................................................................. 49
Pages in Alarm ..................................................................................................... 50
Alarm Window ...................................................................................................... 50
Refreshing Graphics ............................................................................................. 50
Conditional Visibility ........................................................................................... 51
### Table of Contents

Default Control Buttons ................................................................. 51

**Remote Page Selection** .................................................................. 54

**Directory** ...................................................................................... 54

**Operator Input** ............................................................................ 54
  - One-Touch Selection of Variable-Sized Templates ............................ 54
  - Two-Touch Selection of Variable-Sized Control Buttons ................. 55
  - Selecting a Template ..................................................................... 55
  - Variable-Sized Control Button Operation ....................................... 56

**Alarms** ........................................................................................ 56
  - Alarm Summary Page ..................................................................... 57
  - Viewing or Acknowledging Alarms .................................................. 58

**PanelMate PC Pro Password Protection** ......................................... 59
  - Templates with Numeric Entry Selected ....................................... 59
  - Lost PanelMate ePro or PC Pro Password Recovery ....................... 60

**Setup Page** .................................................................................. 60
  - Change Password A or Change Password B .................................... 61
  - Log-in Password A and Log-in Password B .................................... 61
  - Set Date and Time ......................................................................... 61
  - Log-out Password A and Log-out Password B ............................... 62
  - Display System/Configuration Information ..................................... 62
  - Close PanelMate Application .......................................................... 62
  - Cleaning Mode (Available Only on Touchscreen Units) .................. 62
  - Switch to Two Column Keypad or Switch to Three Column Keypad (Available Only on Touchscreen Units) .................................................. 62

**Maintenance Templates** ............................................................... 62
  - Start Monitor ................................................................................. 63
  - Deactivate .................................................................................... 63
  - Change Value ............................................................................... 63
  - Modify Template ........................................................................... 64
  - Change PLC Name ........................................................................ 64
  - Change PLC Ref ........................................................................... 64
  - Maintenance Template Examples ................................................. 65
  - Data Format .................................................................................. 66
Chapter 6: Troubleshooting ............................................................................. 68
 Errors During Run Mode .................................................................................. 69
 Communication Errors ..................................................................................... 69
   Local Errors .................................................................................................... 70
   Remote Errors ................................................................................................ 70
 System Errors .................................................................................................... 72
 Error Codes ........................................................................................................ 72
 Interface Card Errors ....................................................................................... 80
 Runtime Issues .................................................................................................. 81
 Checking User Configuration Compatibility ..................................................... 82
 ePro Troubleshooting ....................................................................................... 83
 ePro Event Viewer ............................................................................................. 84
 Using the NT Event Log to Log Communication Errors .................................. 84
 Replacing the Fuse ............................................................................................ 85
 Calibrating the Touchscreen ........................................................................... 85
   Integrated (Non-Blind Node) Units ................................................................. 85
   Blind Node Units ........................................................................................... 86
 Calibrating the TouchPanel .............................................................................. 86
   Integrated (Non-Blind Node) Units ................................................................. 86
 Using a Mouse in Run Mode ............................................................................ 87
 Placing the PanelMate ePro In Protect Mode ................................................... 88

Chapter 7: Hardware Installation ....................................................................... 89
 Enclosure Selection ............................................................................................ 90
   Enclosure Rating ............................................................................................ 90
   Enclosure Construction .................................................................................. 90
   Enclosure Sizing and Unit Positioning .......................................................... 90
 Communication Cable Selection, Shielding, Grounding and Termination ....... 92
   RS232 Communications (COM2) .................................................................... 92
   RS422 Communications Using an External RS232 to RS422 Converter ......... 93
   RS485 Multi-Drop Communications Using an External RS232 to RS485 Converter ................................................................................................. 95
   Allen-Bradley DH485 Communications ......................................................... 96
   Allen-Bradley Data Highway/Data Highway Plus Communications .............. 96
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modicon Modbus Plus Communications</td>
<td>96</td>
</tr>
<tr>
<td>PROFIBUS DP Communications</td>
<td>97</td>
</tr>
<tr>
<td><strong>Cable Segregation and Placement</strong></td>
<td>98</td>
</tr>
<tr>
<td>Cable Segregation</td>
<td>98</td>
</tr>
<tr>
<td>Cable Placement</td>
<td>98</td>
</tr>
<tr>
<td>Potential Problem Areas</td>
<td>99</td>
</tr>
<tr>
<td><strong>7575T-8 and 7585T-8 Series Cutout Template</strong></td>
<td>100</td>
</tr>
<tr>
<td><strong>7575T-8 and 7585T-8 Series Unit Dimensions</strong></td>
<td>101</td>
</tr>
<tr>
<td><strong>7585K-8 Series Cutout Template</strong></td>
<td>102</td>
</tr>
<tr>
<td><strong>7585K-8 Series Unit Dimensions</strong></td>
<td>103</td>
</tr>
<tr>
<td><strong>7585T-10 Series Cutout Template</strong></td>
<td>104</td>
</tr>
<tr>
<td><strong>7585T-10 Series Unit Dimensions</strong></td>
<td>105</td>
</tr>
<tr>
<td><strong>7585K-10 Series Cutout Template</strong></td>
<td>106</td>
</tr>
<tr>
<td><strong>7585K-10 Series Unit Dimensions</strong></td>
<td>107</td>
</tr>
<tr>
<td><strong>7500 Unit Dimensions</strong></td>
<td>108</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>109</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction

This chapter provides you with an introduction to your ePro unit. The following topics are discussed:

- What does the “e” in ePro represent?
- ePro models
- ePro technical details
- Windows NT Embedded (NTE)
PanelMate ePro

PanelMate ePro combines the world’s most popular Operator Interface with the best features of open platform computing to create the most powerful interface solution available today. It provides the benefits of an open platform with the stability offered in a proprietary or closed platform.

What Does the “e” in ePro Represent?

The “e” in ePro represents the following:

- **Embedded NT (NTE)**—NTE is a customized NT operating system configured to meet the hardware and software requirements of the PanelMate Operator Interface. As a result, NTE is small enough to fit on a Disk-on-Module (DoM) flash memory drive, so there are no “moving parts” in tough factory floor environments.
- **Ethernet**—On-board fast Ethernet is standard on all ePro units and can be used for PLC/Controller communications, data transfer, configuration download and remote troubleshooting.
- **Enhanced**—The ePro features enhanced capacity and performance, such as
  - A configuration that can hold up to 200 pages and 65,000 messages
  - A system that is considerably faster than any other competitive product
  - A system that provides a variety of communication options using OPC connectivity (up to 32 different drivers/OPC servers can be used simultaneously!)
- **Extensible**—The ePro architecture can be extended to include Advanced Technology Services application software to meet your specific needs.

ePro Models

PanelMate ePro display models include an integrated color display. Blind Node (no display) models are available for applications that use external displays. All models feature a resistive touchscreen or a membrane TouchPanel (keypad) for operator input.

Specific PanelMate ePro models come with one prelicensed Kepware OPC driver. These models include the suffix -OPC in the catalog number.

The PanelMate ePro comes in three basic models

- Base Models
- XE Models
- X1 Models

**Base Models**

Base models are Operator Interface units that provide an Ethernet interface, OPC support and an embedded Microsoft operating system ready to run PanelMate configurations.
**XE Models**

XE models are units that have all of the features of the base models with the addition of four Application Kits that are available and ready to run. The Application Kits include

- Document Viewer
- Headline Manager
- Recipe Manager
- Trend Viewer

**Document Viewer**

The Document Viewer enables the retrieval of manuals or other documents from files and web pages through a secure network browser that limits Internet/Intranet access to pre-selected networked information locations.

**Headline Manager**

The Headline Manager provides options for alerting operators to events that require attention. Headline messages such as machine faults, cautions, or alarms are displayed on a one-third screen alert window on the PanelMate display. The Headline Manager can also send the same messages to a remote message display unit or other serial device through a serial port.

**Recipe Manager**

The Recipe Manager enables operators to quickly and easily initiate product changeovers that require changes to PLC control settings. The Recipe Manager stores up to 500 different recipes with as many as 500 ingredients in each recipe. Recipes are downloaded to PLCs as required with a simple push of a button.

**Trend Viewer**

The Trend Viewer provides high-speed real-time trending for creating trend charts that are automatically started with system power up. The Trend Viewer provides on-screen values display, online parameter and time scaling changes, forward/backward time scrolling, statistical analysis, diagrams, and other trending features.

**X1 Models**

X1 models are units that have all of the features of the base models with the addition of one of three Application Kits. One of the following Application Kits can be selected:

- Document Viewer
- Headline Manager
- Recipe Manager
ePro Technical Details

Your ePro unit provides a wide range of useful features that include:

- Windows NT Embedded (an embedded NT operating system)
- PanelMate PC Pro Runtime software
- An Ethernet 10/100 Base-T port on-board
- A 9-pin, RS232 (COM1) Touchscreen/TouchPanel Port
- A 9-pin, RS232 (COM2) Serial Port
- PS/2 ports for both mouse and keyboard
- A USB port for M-Systems DiskonKey Device or Iomega drives, such as PocketZip and Zip
- A VGA port for driving external monitors
- A ½ size slot for authorized ISA cards, such as:
  - Allen-Bradley Data Highway/Data Highway + available through Cutler-Hammer
  - SST ControlNet
  - SST PROFIBUS DP
  - Square D Modbus Plus
- Support for Kepware’s KEPServerEx suite of OPC servers
- UL/cUL and CSA Hazardous Locations, Class I, Division 2 Groups A, B, C, D certified
- CE Mark Certified

Display models have features that include:

- 7.7 in., 8.4 in., or 10.4 in. displays
- Full VGA 640 x 480 resolution, with 256 colors
- A high-resolution resistive touchscreen or membrane keypad
- Approval for use in Type 4, 4X and 12 installations when properly mounted in a correspondingly rated enclosure

Windows NT Embedded (NTE)

Windows NT Embedded is a subset of Windows NT. NT Embedded enables us to customize your PanelMate ePro unit's operating system to eliminate the operating system components that we do not need. Because NTE allows us to protect the operating system (OS) from unwanted software changes, we can make your ePro unit reliable for industrial applications, whereas an open NT operating system is susceptible to lockups from OS file corruption.

Windows NT Embedded uses the same source code base as Windows NT, so the two are very similar in terms of their functionality and capability. The difference is that the NT Embedded developer's tool kit provides tools and utilities to create a subset of NT that matches both the hardware platform and applications software requirements of a target embedded system.
By creating this subset, many of the NT components can be eliminated from the operating system, enabling the system developer to significantly reduce the size of the OS footprint from that of an open PC platform. This size reduction can provide a less expensive system with lower volatile and non-volatile memory requirements, targeted at solving specific application requirements.

NT Embedded is designed for installation on read-only media so the critical files of the operating system cannot be corrupted. This protection results in superior system reliability over desktop systems, which is a key requirement for industrial applications.

PanelMate ePro takes advantage of these key NTE features to provide a low cost, feature-rich OI platform with the stability of a dedicated, proprietary system.
Chapter 2: Getting Started With Your ePro Unit

This chapter describes how to get started with your ePro unit. The following topics are discussed:

- Powering up your ePro unit
- Preparing your ePro unit for online use
- Preparing your ePro for data transfer/software downloads
- Installing software and downloading configurations
- Managing accounts and changing passwords
Powering Up Your ePro Unit

In order to power up your PanelMate ePro unit, you need to provide a 1.6 amp 24-volt power source/supply. Your PanelMate ePro unit is designed to operate at 24VDC -15% / +20%. A removable three-position DC power connector attaches to the unit's connector receptacle. The DC input common (terminal) and the chassis GND terminal are both internally connected to the PanelMate ePro chassis.

Notes:

• Use #18 AWG (0.82mm2) copper wire for power and ground lead connections.
• Power conditioning may be required when the PanelMate ePro unit is installed in areas of poor power quality.
• The ePro unit is designed to operate with a peak inrush current of 16 A, a maximum current of 1.6 A, and a maximum power of 34 watts.

You may find it useful during development to connect both a PS/2 keyboard and PS/2 mouse to your ePro unit.

Power and Ground Instructions

The PanelMate ePro operator interface has been designed to withstand severe environmental conditions typical in industrial installations. However, certain extreme conditions, such as serious ground faults, have the potential to damage the PanelMate ePro operator interface or cause other damage. In all cases, the end user must ensure that the installation is protected from these extreme conditions and follows local codes and electrical standards and regulations.

The following recommendations are intended to help protect the PanelMate ePro unit from damage due to current swells, ground faults, or ground potential differentials that can occur in electrical system installations.

• Use an isolated power supply
• Use single point grounding
• Install a power supply solely for the PanelMate ePro
• Use a current-limiting power supply
• Add circuit breakers

Use an Isolated Power Supply
AC to DC power supplies are typically isolated while DC to DC power supplies are often non-isolated. Check the power supply specifications to ensure that the power supply is fully isolated. If used in a Class I, Div 2 environment, then the external power supply must be appropriately rated.

Use Single Point Grounding
The external power supply and the PanelMate ePro unit should be grounded to the same point. Single point grounding should be practiced even when the devices are located in separate enclosures to help prevent ground loop issues.

Install a Power Supply Solely for the PanelMate ePro
If the current external power supply is used for multiple devices, add an external power supply specifically for the PanelMate ePro unit. A separate external power supply will better protect against system transients and ground potential issues. If used in a Class I, Div 2 environment, the external power supply must be appropriately rated.

Use a Current-Limiting Power Supply
The external power supply should not be able to source more than five amps. If used in a Class I, Div 2 environment, the external power supply must be appropriately rated.

Add Circuit Breakers
Install circuit breakers (ATS Catalog Number SPCL2C04) on both the supply and return paths between the PanelMate and the external power supply to protect against current swells on the return path. The circuit breakers should be rated from three to five amps.

First Time Power Up Process
Once power is connected to your ePro unit, the following occurs:

1. A DOS prompt appears on the screen informing you that the unit is initializing system resources.
2. The Windows NT Embedded operating system boots up.
3. A Delay–Connecting to Touchscreen Controller window appears, informing you that the unit is loading the touchscreen driver.
   
   Note: This window may not appear on the screen long enough to see.
4. The PanelMate ePro demo application launches and the **Welcome to PanelMate ePro** demo window appears. This demo allows you to become familiar with the PanelMate ePro user interface.

**Note:** You can power down your ePro unit at any time after the operating system has fully booted up.

**Closing the ePro Demo**

To close the PanelMate demo application

1. Click the **Get Page** button on the lower-right corner of any demo page
2. Click the **More** button
3. Click the **Setup Page** button
4. From the Setup Page, click the **Close PanelMate Application** button
5. Click the **Execute** button

**Result:** The demo application closes and you are returned to the ePro desktop.

**Note:** You can also click the **Menu** button on any demo page and then click the **Exit** button on the Menu Page to go directly to the Setup Page.

Once you are returned to the ePro desktop, notice that the **Cutler-Hammer DDE Server Data Daemon** utility is still running. This utility can be closed after you stop the ePro demo. To close the Cutler-Hammer DDE Server Data Daemon, click the utility on the task bar to maximize its window and then click the exit shortcut button (X) at the top of the window, or use the **File>Exit** menu command.

**Preparing Your ePro Unit for Online Use**

After using the demo application to familiarize yourself with the ePro user interface, you can connect to the ePro unit in order to do one or more of the following:

- Install an OPC server
- Install the latest PanelMate ePro Runtime software
- Download an ePro configuration

**Note:** All ePro units have the Kepware OPC server preloaded but not activated with the exception of the ePro OPC bundled models (these models have the suffix –OPC in the catalog number). OPC bundled models are prelicensed to run any one Kepware OPC driver. Purchase of a Kepware OPC server is required in order to obtain a serial number for software activation on non-OPC bundled models. Kepware OPC drivers can be installed using the Kepware CD.
Communicating to a PLC or Controller
Your PanelMate ePro unit can communicate to a PLC or controller via:

- A serial connection (COM2, RS232)
- An optional interface card
- An Ethernet connection (Refer to the Connecting to Your ePro for Data Transfer/Software Downloads section for more information about setting up an Ethernet connection)

Connecting to the Serial Port (COM2)
The external serial port may be used for communications with a PLC or controller.

If you need local printing of alarms and messages, use the Configuration Software to select a serial printer. Refer to the Configuration Software online help and the PanelMate Configuration Editor User's Manual for more information.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>RS232 Receive Data (Input)</td>
</tr>
<tr>
<td>3</td>
<td>RS232 Transmit Data (Output)</td>
</tr>
<tr>
<td>5</td>
<td>Signal Ground</td>
</tr>
<tr>
<td>7</td>
<td>RS232 Request to Send (Output)</td>
</tr>
<tr>
<td>8</td>
<td>RS232 Clear to Send (Input)</td>
</tr>
</tbody>
</table>

Caution: Your PanelMate ePro unit is not equipped with isolated serial ports. Check for any ground potential difference between your communication equipment and your PanelMate ePro unit. If there is a ground potential difference, your communication equipment will need to be isolated.
Installing an Optional Interface Card

To install an optional interface card in your PanelMate ePro unit

1. Disconnect power from your PanelMate ePro unit.
2. Use a Phillips screwdriver to unscrew the six screws located on the back of your PanelMate ePro unit and remove the back cover.
3. Use a Phillips screwdriver to remove the screw that secures the slot cover and remove the slot cover.
4. Place the interface card in the slot and secure the interface card with the screw from the slot cover.
5. Reassemble your PanelMate ePro unit and tighten the six screws located on the back of the unit.
Preparing Your ePro for Data Transfer/Software Downloads

You can connect to your PanelMate ePro unit to transfer data and download software via

- An Ethernet connection using static IP addressing, using either
  - A point-to-point connection (direct) using a shielded Cat 5 Ethernet crossover cable
  - A network connection using a local Ethernet hub/switch and a pair of shielded Cat 5 Ethernet patch cables
- An Ethernet workgroup or domain on a plant/local network connection with a DHCP server assigning the ePro's IP address
- A USB connection to an M-Systems DiskonKey or Iomega drive

PanelMate ePro factory settings are

- TCP/IP protocol
- Computer name: EPRO
- Workgroup name: WORKGROUP
- IP Address: 192.168.0.1
- Subnet Mask: 255.255.255.0

Other items to consider when communicating using Ethernet include

- All static IP addresses must be unique
- All computer names must be unique
- All subnet masks must match
- We recommend that all workgroup names match
- We recommend using a shielded Cat 5 cable for industrial applications

Connecting to Your ePro Via the Ethernet

When connecting your ePro through any of the following methods, the unit you are connecting to should appear in the network neighborhood of a Microsoft operating system. If it does not appear in the network neighborhood, use the **Find computer** or **Search computer** utility to find the desired unit. When searching, you can search by computer name or by the unit’s IP address.
Setting Up a Point-to-Point (Direct) Ethernet Connection

To connect to your PanelMate ePro unit using this method, complete the following steps:

1. Use a crossover cable.
2. Connect one end of the cable to the Ethernet port on your computer and the other end of the cable to the Ethernet port of your PanelMate ePro unit.
3. Power up your computer and your PanelMate ePro unit.

Result: A green LAN Present LED indicator should appear next to the Ethernet port.

Once you have established the physical connections, the next step is to establish the correct logical connections between your computer and your PanelMate ePro unit. If you are using the ePro default IP address, the computer IP address should be assigned a unique value where the first three fields match that of the ePro. For example, if the IP address of the ePro is 192.168.0.001, then the computer IP address would be 192.168.0.xxx where xxx is between 0 and 255 and is not equal to 001, which is the default ePro value.

Setting Up an Ethernet Connection Using a Hub/Switch

This method can be used to set up a local workgroup using only static IP address. To set a local workgroup with dynamic only or static and dynamic combined see Setting Up a Local Ethernet Workgroup Using DHCP Server. To connect to your PanelMate ePro unit using this method, complete the following steps:

1. Use patch cables.
2. Power up the hub/switch and connect a patch cable from both your computer’s and your PanelMate ePro unit’s Ethernet port to the hub or switch. Other units can be added.

Note: Do not to use the port labeled Uplink on the hub or switch.

Result: A green LAN Present LED indicator should appear next to the Ethernet port on each machine.
3. Once you have established the physical connections, the next step is to establish the correct logical connections. If you are using the ePro default IP address, the computer IP address should be assigned a unique value where the first three fields match that of the ePro (for example, 192.168.0.xxx where xxx is between 0 and 255 and is not equal to any other assigned value).

Notes:

- If there are multiple ePro units on the network, you will need to change the Computer Name and IP address on each workgroup unit to be unique.
- You can build user accounts and passwords locally on all Windows NT or NT derivative systems when managing a local workgroup. Refer to the Managing Accounts and Changing Passwords section for more information.

Setting Up a Local Ethernet Workgroup Using DHCP Server

Use a DHCP server to set up a local Ethernet workgroup if you are setting up a local network using a hub or switch that will not be connected to a larger plant network.

To connect to your PanelMate ePro unit using this method, complete the following steps:

1. Use patch cables.

2. A DHCP router must be used to provide IP addresses to any units that are set up for automatic IP addressing. If any units on the local workgroup are set up for static addressing, the DHCP router must support this as well. In most cases the router must be powered up first, before any of the units, so the router can provide any addressing needs. Powering the router up after any units are powered on may result in a unit not receiving an IP address. Connect the patch cables from the units to the router.

Result: A green LAN Present LED indicator should appear next to the Ethernet port on each machine.

3. Once you have established the physical connections, the next step is to establish the correct logical connections. If you are using the ePro default IP address format, all other IP addresses should be assigned a unique value where the first three fields match that of the ePro (for example, 192.168.0.xxx where xxx is between 0 and 255 and is not equal to any other assigned value).
Notes:

- If there are multiple ePro units on the network, you will need to change the computer name and IP address on each workgroup unit to be unique. If dynamic addressing is desired, you may also change their network settings to obtain an IP address automatically.

- You can build user accounts and passwords locally on all Windows NT or NT derivative systems when managing a local workgroup. Refer to the **Managing Accounts and Changing Passwords** section for more information.

---

**Setting Up PanelMate ePro on a Domain Network Using DHCP Server**

Working on domain networks is the same as working in a local workgroup. You can use static or dynamic addressing (DHCP) to establish a connection to the network. PanelMate ePro can share information with other units of the same workgroup or other workgroups as long as none of the units are logged on to a domain.

PanelMate ePro can connect to resources logged on to a domain by the user supplying a valid “domain name”, “user id”, and “password” (these are provided by the network administrator). This procedure will create a connection to the domain resource that will last as long as it is not manually removed or a loss of power to any of the connected devices does not occur. If a connection to a domain resource is required at all times, including after a power down, the following lines can be added to the **PMStart.cmd** file located on the ePro D:\ partition.

Add these lines to create an automatic connection that is not assigned a drive letter:

```
NET USE /PERSISTENT:NO
NET USE \BIGSERVER /USER:MYPLANT\JAMESB agent007
```
Add these lines to create an automatic connection that is assigned a drive letter:

```
NET USE /PERSISTENT:NO
NET USE X: /D
NET USE X: \BIGSERVER\SECRETS /USER:MYPLANT\JAMESB agent007
```

Where:

- **X** = Desired drive letter to be assigned
- **BIGSERVER** = Domain resource being connected to
- **SECRETS** = Folder on domain resource to connect to
- **MYPLANT** = Domain name
- **JAMESB** = User ID
- **agent007** = Password

PanelMate ePro cannot automatically log-on to a domain network because it is factory set to support workgroups only and cannot be configured to a domain network even though domains is a valid option in the network settings area of PanelMate ePro. If you choose to change PanelMate ePro’s configuration from workgroup to domain you will receive an error message.

### Connecting to the ePro Using an M-System DiskonKey Device

The M-Systems DiskonKey driver has been pre-loaded and enabled on the PanelMate ePro. (Units shipped before April 2003 have the Iomega driver pre-loaded and enabled.) You can connect a DiskonKey device to your ePro unit's USB port to copy files and to install ATS supported third-party software. The M-System DiskonKey drive is listed as **Removable Disk (Z:)**.

**Note**: Other USB products, such as Iomega devices, may not be used unless the DiskonKey drivers are disabled.

#### How to Disable DiskonKey USB drivers

You can disable the DiskonKey drivers "usbbulk" and "usbdrv" by selecting **Start>Settings>Control Panel>Devices**. With the **Devices** window open, find and highlight the device named "usbbulk". With the device highlighted select: **Startup…>Disabled>OK>Yes**. Follow the same instructions to disable "usbdrv". The drivers will be disabled after rebooting the unit.

#### How to Re-enable DiskonKey USB drivers

You can disable the currently enabled USB driver and recycle power to complete the disabling process.
Enable the DiskonKey drivers "usbbulk" and "usbdvr" by selecting 
Start>Settings>Control Panel>Devices. With the Devices window open, find and 
highlight the device named "usbbulk". Highlight the device and select 
Startup…>System>OK>Yes. Follow the same instructions to enable "usbdvr". Recycle 
power on the ePro to complete the enabling process

Connecting to the ePro Using an Iomega USB Device

The PanelMate ePro units have the Iomega USB device driver preloaded. On units 
shipped after April 2003 the Iomega driver has been disabled and the M-Systems 
DiskonKey driver is enabled. See the steps above for disabling the M-Systems 
DiskonKey USB drivers. Next enable the Iomega USB drivers (see instructions that 
follow). Once installed, Iomega devices such as the PocketZip can be used to copy files 
to your ePro.

How to Enable Iomega USB Driver.

With the current USB driver disabled, you can enable the Iomega driver by selecting 
Start>Settings>Control Panel>Devices. With the Devices window open, find and 
highlight the device named "iomusb". With this device highlighted, select 
Startup…>Boot>OK>Yes. Recycle power to complete the enabling process.

How to Disable Iomega USB Driver

You can disable the Iomega USB driver by going to the Devices window in the Control 
Panel and disabling the Iomega driver "iomusb". To disable the Iomega driver select 
Start>Settings>Control Panel>Devices. With the Devices window open, find and 
highlight the device named "iomusb". Highlight the device and select 
Startup…>Disable>OK>Yes. Recycle power to complete the disabling process.
Connecting Windows 98 PCs to an ePro

Due to differences in network login and security functionality, there are different rules for connecting Windows 98 or Windows ME PCs to ePros than the rules for connecting PCs based on the Windows NT based operating system to ePros. Windows NT based operating systems include Windows NT 4.0, Windows 2000, and Windows XP. NT based PCs can log on to shared PC resources and provide a specific account and password unrelated to the currently running user account, whereas Windows 98 based PCs can only log on to a network PC resource using the same account name as the one used when booting up the Windows 98 PC. Since the ePro is a workgroup member and cannot operate as a Domain administered PC, all login security is verified to user accounts on the ePro.

This means that the ePro must have a local user account with the same name and identical password as the user account on the Windows 98 PC. New user accounts can be created on the ePro using **Start>Programs>Administrator Tools>User Manager**.
To create a new user account from the User Manager Window, use the User>New User... command or select an existing user with the same user privileges as the new user and use the User>Copy command. The following dialog box must be completed.

New User Dialog Box

The Username field must match the user login account from the Windows 98 PC. The information entered in the Full Name and Description fields will appear in the User Manager window for descriptive purposes. The Password and Confirm Password fields must have identical entries and should match (case sensitive) the Windows 98 login password. The User Must Change Password at Next Logon checkbox should be unchecked and the Password Never Expires checkbox should be checked. An example of a properly completed dialog box is shown on the following page:
Chapter 2: Getting Started With Your ePro Unit

New User Dialog Box (properly completed)

Next, click the Groups button in the lower-left corner and assign the groups associated with the new user from the following dialog box.

Group Membership Dialog Box

Unless the ePro administrator has modified the share attributes of the shared ePro folders, the default Users group has sufficient privileges to copy files to and from the ePro. Once the OK buttons on all of the dialog boxes are clicked, the user will be able to connect both PCs to the same Ethernet network, and from the Windows 98 PC you will be able to browse or “find” the ePro on the network and copy files to and from its shared directories.
Connecting Windows ME PC’s to an ePro

To connect a Window ME PC to an ePro

1. Install NetBEUI.
2. Install the File and print sharing service.
3. Under the properties for both TCP/IP and NetBEUI, select the binding for File and print sharing, MS Family logon, and Client for MS networks.
4. Share the desired drive to be seen from the ePro (for example, the CD-ROM). Sharing can be set through the Shares tab under the drive properties.
5. From the ePro, select Find Computer from the Start menu and type the name of the PC (for example, My Laptop).
6. Double-click the PC name.
   **Note:** If the share is password protected, use the laptop user name and the correct share password (for example, User Name aa Password bb).

To view a file on the ePro from a Window ME machine

1. Install TCP/IP for the correct adapter and set it to a static IP address.
2. Create a new user on the ePro with the same user name and password as the Windows ME logon on the laptop.
3. Select Find Computer from the Start menu and type in the name of the ePro.

Installing Software and Downloading Configurations

Typical data transfers and software downloads may include the following:

- Configuration Downloads
- Driver Installation
- PanelMate PC Pro Installation
- OPC Server Installation

C/D Partitions

Your ePro unit comes with two drive partitions

- C:\ partition
- D:\ partition
Cutler-Hammer recommends that you use these drives as follows:

<table>
<thead>
<tr>
<th>Drive Partition</th>
<th>Recommended Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>C: \</td>
<td>Use the C:\ partition for software installations, to store all of your programs and purchased software. This partition can be protected (locked down), so you should use it to store all data on the ePro that needs to be protected.</td>
</tr>
<tr>
<td>D: \</td>
<td>Use the D:\ partition to store data that changes on a regular basis, such as configurations and message library (.csv) files.</td>
</tr>
</tbody>
</table>

**Types of Software That Can Be Installed**

You can install PanelMate PC Pro Runtime software, PanelMate PC Pro drivers, Kepware OPC servers, and selected SST OPC servers on your PanelMate ePro unit. Note that PanelMate PC Pro Runtime software V2.20 (or greater) is required for proper operation of the PanelMate ePro TouchPanel models.

Other third-party software packages or OPC servers that have not been authorized may not install or run properly for the following reasons:

- NT Embedded is different from the commercial open Windows NT operating system. Therefore, some drivers, services and support components that other software programs require may not be present in the PanelMate ePro NT Embedded operating system.
- There may not be enough disk space (DoM non-volatile flash memory) to install or configure unauthorized software.
- The ePro unit does not support runtime writes to the operating system DoM partition. Therefore, if a third-party package routinely tried to write log files or diagnostics to that partition, it would be redirected to a RAM buffer that could take up all available RAM and result in unstable system operation.

Both the ePro’s DoM module and RAM have been sized for those software packages that have been qualified for the unit and have validated their runtime integrity. Based on the reasons stated above, Cutler-Hammer recommends that you do not install any other software. If you choose to install unauthorized software, you will be assuming responsibility for overall system integrity and reliability.

**Installing Software**

There are two methods for installing authorized software on your PanelMate ePro unit:

- Ethernet connection
- M-Systems DiskOnKey or Iomega USB device connected to the ePro’s USB port
Installing Software Using an Ethernet Connection

Using Ethernet, you can connect your ePro unit directly to a PC using either a standard Patch 5 crossover cable or through a standalone Ethernet hub or switch. You can also connect your ePro unit to your company’s Ethernet network (you may need the assistance of company IT personnel to establish your ePro unit’s IP address or set the ePro unit’s TCP/IP properties to DHCP). See the earlier sections in this chapter that address Ethernet connections.

In either case, to install software using Ethernet, you need to

- Share a network drive for which your ePro unit has access rights
- Browse to that shared drive from the ePro unit using Explorer
- Run the appropriate software installation setup executable.

Installing Software Using an M-Systems DiskonKey Device

To install software using an M-Systems DiskonKey device

1. Copy any installation files from the installation CD to the DiskonKey device using a desktop PC that has both CD and USB support.
2. Connect the DiskonKey device to the ePro USB port and wait for the LED to stop flashing.
3. Browse to Removable Disk (Z:) drive from your ePro unit using Explorer, and run the appropriate setup executable file.
4. When completed and the LED is not flashing, the DiskonKey device can be removed.

Installing Software Using an Iomega USB Device

To install software using an Iomega USB device such as a Zip or PocketZip

1. Copy any installation files from the installation CD to the Zip/PocketZip removable drive, using a desktop PC that has both CD and USB support.
2. Power down the ePro.
3. Connect the Zip/PocketZip drive to the ePro unit’s USB port, making sure that the drive is powered if it requires an external power supply.
   Note: Most Zips and PocketZips are powered directly from the USB port of your ePro unit.
4. Power up your ePro unit.
   Result: You can see the USB drive listed as a Removable Disk (E:) in Explorer.
5. Browse to the drive from your ePro unit using Explorer, and run the appropriate installation setup executable.
To install software using an Iomega CD RW USB device (read only from your ePro unit)

1. Power down the ePro.
2. Connect the drive to the ePro unit’s USB port, making sure that the drive is powered.
3. Power up your ePro unit.
   **Result:** You can see the USB drive listed as a **Removable Disk (E:)** in **Explorer**.
4. Browse to the drive from your ePro unit using **Explorer**, and run the appropriate installation setup executable.

**Downloading a Configuration (.pps File)**

Once you are connected to the PanelMate ePro unit using an Ethernet connection, an M-Systems DiskonKey, or an Iomega USB drive, you can copy a PanelMate PC Pro configuration to the shared application drive (**D:**) of the ePro using **Explorer**.

Using an Ethernet connection, you may initiate the copy from your development PC or from the ePro unit, assuming the configuration is located in a shared network drive or directory.

**Uninstalling Software**

Confirm that the ePro’s Protect Mode status is in Normal Mode before uninstalling software.

**Uninstalling PanelMate Software**

There is no need to remove PanelMate PC Pro Runtime software from the ePro. If you want to upgrade to a newer runtime version simply run the install program of that newer version. There is similarly no need to remove a native PanelMate PC Pro driver from the ePro. You can upgrade the driver version without removing the previous driver since the driver installation replaces older files with updated ones. If you no longer need a driver that has been installed simply remove the driver executable from the directory “C:\Pmconfig\Ntonline.”

**Uninstalling OPC Servers**

If you need to remove an installed SST OPC server, the uninstall program option can be found on the SST installation setup menu.

The Kepware OPC server can be uninstalled using the installation CD by running “Setup.exe” and selecting "Remove" from the Kepware Setup Utility dialog box. This procedure will completely remove all installed components.

PanelMate ePro OPC Bundled models ("OPC" in catalog number) are prelicensed to run one Kepware OPC driver. The license remains with the hardware and cannot be transferred.
Uninstalling Touchscreen Drivers

Uninstalling TouchKO Drivers
To uninstall the TouchKO touchscreen driver, delete the \C:\winnt\tko.exe and the \C:\winnt\tko.dat files. The TouchKO touchscreen driver is installed on all PanelMate ePro models that have an integrated display.

Uninstalling Elo Drivers
To uninstall the Elo touchscreen driver, select Start>Run and enter:

C:\winnt\Isuninst.exe –f "C:\EloWinNt\mmuninst.isu"

The Elo touchscreen driver is installed on all PanelMate ePro blind node models.
Managing Accounts and Changing Passwords

There were two accounts set up on your PanelMate ePro unit when it was shipped from the factory: the Administrator account and the Guest account. The default Windows Guest account has been disabled. You can enable or remove this account if necessary.

The password for the Administrator account is Administrator, and the password for the Guest account is Guest.

Notes:
- ePro passwords are case sensitive.
- ePro account names are not case sensitive.

The ePro is set up to automatically log in to the Administrator account, which is why the normal Windows NT Security dialog box does not appear upon bootup.

If you are connecting your PanelMate ePro unit to a larger network, you might want to modify the Administrator account name and password to protect the ePro unit from unauthorized access.

Notes:
- The ePro Administrator account has been created for use by Cutler-Hammer technical support.
- The PanelMate ePro unit must be in Normal mode before modifying the account name and password or changing the Auto Logon values. Refer to the Placing Your ePro Unit in Protect Mode section for more information.

Modifying the Administrator Account Name and Password

You can modify the Administrator account name password from the Windows NT Security login dialog box. This dialog box can be accessed via the keyboard, with the <CTRL> <ALT> <DEL> keystroke.

Once the Administrator password has been successfully modified you need to run the Windows NT Auto Logon utility in order to continue to automatically log in to the Administrator account at bootup.

Using the Auto Logon Feature

The ePro Auto Logon feature is used to automatically log into a specified account name and password. By default, the Auto Logon feature is enabled and logs into the Administrator account, using Administrator as the account name and password.

If you want to change the Auto Logon features, refer to the descriptions below.

Note: You must have administration privileges in order to disable/change to Auto Logon feature.
How to Disable the Auto Logon Feature

To disable the Windows NT Auto Logon utility

1. Click Start>Run.
   Result: The Run dialog box appears.

2. In the Open field, type the following:
   “C:\Program Files\ePro Tools\SetAutoLogon.bat” NONE
   Note: Quotes are required.

3. Click the OK button.
   Result: A message dialog box appears, informing you that information in the
   SetAutoLogon.reg has been successfully entered into the registry.
   Note: The next time that you boot up your PanelMate ePro, the Windows NT
   Security login dialog box appears.

How to Re-enable/Change the Auto Logon Feature

To re-enable/change the Windows NT Auto Logon utility

1. Click Start>Run.
   Result: The Run dialog box appears.

2. In the Open field, type the following:
   “C:\Program Files\ePro Tools\SetAutoLogon.bat” Account_Name Password
   (with the Account Name being your account name and the Password being
   your password for the ePro unit)
   Note: Quotes are required.

3. Click the OK button.
   Result: A message dialog box appears, informing you that information in the
   SetAutoLogon.reg has been successfully entered into the registry.

Notes:

- Account names are not case sensitive, but passwords are case sensitive.
- If you only change the password, the next time that you boot up, your ePro
  automatically logs on with the new password that you just assigned. If you change
  the account name and password, the next time that you boot up, the Windows NT
  Security login dialog box appears. You must manually type the account name and
  password that you just assigned. All other logons after this initial logon will be
  automatic.
- If you do not have Administrator privileges and you attempt to change the account
  name and password, an error message appears, and no changes are made to the
  Auto Logon values. See How to Bypass the Auto Logon Features section for more
  information.
How to Bypass the Auto Logon Feature

If you need to switch the logon user back to the Administrator account, you may bypass the Auto Logon feature by connecting a PS/2 keyboard to your ePro and pressing the left Shift key while booting up. The Windows NT Security login dialog box appears, which allows you to enter a different account name and password.
Chapter 3: Launching a PanelMate PC PRO Configuration

This chapter describes how to start the PanelMate PC Pro Runtime software. The following topics are discussed:

- Launching methods
- Power-up sequence
- Run mode
Launching Methods

There are a number of recommended ways to launch a PanelMate PC Pro configuration (*.pps file)

- Use the startup **PMStart.bat** file
- Use the **Start>Run PMStart** command
- Use the **Start>Run** command
- Double-click the .pps file within the **Explorer** utility

Using the Startup **PMStart.cmd** File to Launch a Configuration

When your ePro unit boots up, it automatically launches the ePro demo. If you would like the ePro unit to automatically launch your configuration (.pps file), you can do so by editing the **PMStart.cmd** file found in the root directory of the D:\ partition using Notepad.

If the PanelMate ePro is an XE or X1 model, the **PMStart.cmd** file includes additional commands for the Application Kits. Refer to the Application Kit manuals for details on how to modify the command file appropriately.

To edit the **PMStart.cmd** file

1. Connect a PS/2 mouse and keyboard to your ePro unit.
2. Reboot your ePro unit.
3. Click **Start>Explorer**.
4. Browse to the D:\ partition, then right-click the **PMStart.cmd** file and click **Edit**.  
   **Result:** Notepad is launched.
5. Edit the following line in the **PMStart.cmd** file by replacing the **MyConfig.pps** file name with the name of your ePro configuration.
   
   ```
   set MY_CFG=d:\cfg\MyConfig.pps
   ```
6. Save the edited **PMStart.cmd** file, then close Notepad.

**Note:** If you prefer not to edit the **PMStart.cmd** file, you can still automatically launch your configuration by renaming it to match that of the **Myconfig.pps** filename in the original **PMStart.cmd** file. If you choose to do this, first delete the **MyConfig.pps** (the demo configuration) and the **chddesrv.exe** (the demo data source) files from Cfg directory of your D:\ partition. Deleting these files conserves the ePro memory resources on your D:\ partition. Then copy your renamed file to the **Cfg** directory of your D:\ partition.
Using the Start>Run Command

To launch a configuration from the Start>Run command with default settings, use this command syntax:

```
c:\pmcofig\ntonline\pmc.exe d:\cfg\appname.pps
```

Where `app_name.pps` is the name of the configuration.

**Note:** The following command line switches are available from the Start>Run command:

- Secure (full screen mode) or Unsecure (-u) mode. Secure mode is the default mode, and in this mode the task bar is hidden. In Unsecure mode, your configuration appears in a window.
- Communications Enabled mode (default) or Disabled mode (-g). Disabled mode is the same as graphics mode and is used in demo mode, with no communications.
- PanelMate PC Pro Application (default) or any PanelMate .pps Application (-a).

Be sure to leave a space between multiple switches, for example:

```
c:\pmcofig\ntonline\pmc.exe d:\cfg\appname.pps-u -g
```

Power-Up Sequence

Once power is connected to your ePro unit, the following occurs:

1. A DOS prompt appears on the screen, informing you that the unit is initializing system resources.
2. The Windows NT Embedded operating system boots up.
3. A Delay-Connecting to Touchscreen Controller window appears on integrated display units, informing you that the unit is loading the touchscreen driver.
4. The PanelMate ePro demo application launches and the **Welcome to PanelMate ePro** demo window appears. This demo allows you to become familiar with the PanelMate ePro user interface.

Run Mode

The following message is displayed while PanelMate PC Pro loads the specific configuration:

**Loading Configuration**

At this point in the initialization, the integrity of the Executive Firmware and integrity of the User Configuration have been verified. The proper driver is also known to be installed. The ePro displays the Loading Status Screen while performing the initialization procedure outlined below. The time to complete the initialization depends upon the complexity of the configuration. The complexity of the user configuration is determined by the density of the pages, number of alarm conditions, and the number of control bits that must be initialized in the process control device(s).
**Note:** If the configuration contains an address reference error it fails to run or generates an Exception Error when trying to load. To find the error, run the verify utility in your PanelMate Power Pro Configuration Editor software.

The Loading Status Screen displays the name, date, and time of the configuration being loaded, the component that is currently being loaded, the percentage of the configuration that has been loaded, and the percentage of the usable free memory remaining (based on the largest contiguous block).

The following steps outline the Run mode initialization procedure:

1. Load system parameters
2. Load PLC name and port table
3. Load message library
4. Load page passwords/titles
5. Load system online labels
6. Load symbol library
7. Load normal character font
8. Load graphic character font
9. Load double-high character font
10. Load quad character font
11. Load configuration pages
12. Create the Run mode database from page component files, verify all expressions, and process control device references
13. Allocate memory
14. Create block reads
15. Begin communications with the process control device
16. (Optional) Control bit initialization; every control bit reference is initialized (if System Parameters is checked) as follows:

- Normally Closed Momentary  Set to 1
- Normally Open Momentary    Set to 0
- Maintained and Toggle      Unchanged

Also send remote bits (Passwords, etc) to process control device(s)

**Note:** If process control device communications are not valid, the communication retry process could be lengthy.

17. Update the Startup Page information and display

**Note:** If the Startup Page is password protected, the protection will be ignored during startup. Subsequent selections of that page will be password protected.

18. Remote send of Startup Page information to process control device

**Notes:**

- The Loading Status screen displays each portion of the configuration as it is being loaded. Cutler-Hammer suggests that the Configuration Verifier (accessed by the Verify selection in the File Menu) be executed on every configuration before downloading to an ePro for online operation.

- Only one PanelMate PC Pro configuration can be active at a time.
Chapter 4: Protecting Your ePro Operating System and Runtime Files

This chapter describes how to protect your ePro operating system and runtime files.

The following topics are discussed:

- Placing your ePro unit in protect mode
- Placing your ePro unit in normal mode
- Checking the protect mode/normal mode status
Placing Your ePro Unit in Protect Mode

The PanelMate ePro has a unique and exclusive feature that allows you to protect information stored on the C:\ partition of your operating system. This feature ensures that data and operating system files cannot be modified by anyone, or corrupted by unexpected power disruptions. As a result, you can be confident that the ePro meets your rigorous industrial environmental requirements and can be protected against all unauthorized alterations.

To activate Protect mode, click Start>Programs>ePro Tools>Activate Protect Mode.

**Notes:**

- Once the OS is protected (locked down) you cannot install an update to the PanelMate ePro Runtime software, ePro driver, or OPC server without first unlocking the operating system.
- Once you place your PanelMate ePro into Protect mode, you must reboot in order for the Protect mode to be activated.
- You must have administrative privileges to activate Protect mode.

Placing Your ePro Unit in Normal Mode

After the PanelMate ePro’s operating system has been placed into Protect mode (its operating system has been locked down) you may want to update critical programs such as the ePro Runtime software, communications driver, or OPC server. To update programs, unlock the operating system and place your ePro unit back into Normal mode.

To place your ePro unit back into Normal mode

1. Connect a keyboard to the keyboard port (lower PS/2 connector) on your ePro unit and cycle power to your ePro. When you see the text **OS Loader V4.01 Press space bar NOW to invoke hardware profile last known good menu**, press the space bar.

2. From the Hardware Profile/Configuration Recovery menu, press the letter **L** on your keyboard and press the **<Enter>** key to place the unit back into Normal mode.

This places the ePro in back into Normal (unlocked) mode, so that you can update your operating system components on the C:\ partition. Once you have completed the operating system update reactivate Protect mode (lockdown) to once again protect your ePro unit’s C:\ partition from potential corruption.

Checking the Protect Mode/Normal Mode Status

You can check the Protect mode/Normal mode status of the C:\ partition by clicking Start>Protect Mode Status.
This chapter describes the PanelMate ePro run mode. The following topics are discussed:

- Run mode
- Online page layout
- Remote page selection
- Directory
- Operator input
- Alarms
- PanelMate PC Pro password protection
- Setup page
- Maintenance templates
Touchscreen Units and Run Mode

All PanelMate ePro touchscreen units (7585T, 7575T, 7500) can run applications (.pps files) that are designed for one touch or two touch operations. Applications that include one-touch button templates are designated by selecting the Direct Select checkbox in the Systems Parameters - General Tab dialog box.

TouchPanel Units and Run Mode

The PanelMate ePro TouchPanel units (7585K series) are designed to run PanelMate PC Pro in Keypad or Mouse Mode. When Keypad Mode is selected, the Touchpad Area should be in Matrix Mode (see the diagram below for Touchpad Area location). Touches in the Touchpad Area while running PanelMate PC Pro will select one of fifteen points in the default 3 x 5 matrix (grid). This function is ideal for applications that use the standard templates and for applications that were originally designed for any of the PanelMate Power Pro TouchPanel units.

Touchpad Area of the ePro TouchPanel Unit

The ePro TouchPanel units (non-XE models) are preconfigured to be in Keypad Mode with Matrix Mode ON when they are shipped from the factory. Applications that are downloaded to an ePro TouchPanel unit with Keypad Mode selected and Matrix Mode ON must NOT have the Direct Select checkbox checked. One-touch application will not function correctly on an ePro TouchPanel unit that is in Keypad Mode. Note that the Direct Select checkbox is found in the Systems Parameters - General Tab dialog box when using the PanelMate Configuration Editor.

If you want to change the mode of the ePro TouchPanel unit and use the Touchpad area as a mouse pad (returns mouse movement positions versus 3 x 5 absolute positions), then you must change the PanelMate PC Pro Mode from Keypad to Mouse, and you must turn the Matrix Mode OFF. Applications downloaded to an ePro TouchPanel unit that is configured to be in the Mouse Mode with Matrix Mode OFF will function per the
Direct Select checkbox status. PanelMate ePro XE units are shipped from the factory with Mouse Mode selected and Matrix Mode OFF. This setup makes it easy to use the Touchpad Area as an input device for the application kits.

The table below describes the combinations of modes and application types that are allowed.

<table>
<thead>
<tr>
<th>PM PC Pro Mode</th>
<th>Matrix Mode Checkbox Status</th>
<th>Direct Select Checkbox Status</th>
<th>PanelMate ePro TouchPanel Operations</th>
</tr>
</thead>
</table>
| Keypad         | Matrix Mode ON             | Direct Select OFF             | • Works like a PanelMate Power Pro TouchPanel unit  
|                |                            |                               | • Button templates require two touches to activate  
|                |                            |                               | • If multiple templates are within a matrix cell on the screen, then the corresponding Touchpad Area matrix cell must be pressed multiple times to "cycle" through the templates until the desired template is highlighted (selected) |
| Keypad         | Matrix Mode ON             | Direct Select OFF             | DO NOT USE. RESULTS IN INCONSISTENT OPERATION |
|                | or ON                      |                               | |
| Mouse          | Matrix Mode ON             | Direct Select OFF             | DO NOT USE. RESULTS IN INCONSISTENT OPERATION |
| Mouse          | Matrix Mode OFF            | Direct Select OFF             | • Works like a touchscreen unit but using a touchpad instead of a touchscreen  
|                | or ON                      |                               | • Button templates require two touches to activate |
|                |                            |                               | • Template selection requires pointing directly to the desired template |
| Mouse          | Matrix Mode OFF            | Direct Select ON              | • Works like a touchscreen but using a touchpad instead of a touchscreen  
|                |                            |                               | • Button templates require one touch to activate  
|                |                            |                               | • Template selection requires pointing directly to the desired template |

**PanelMate PC Pro Mode Selection**

Before changing the PanelMate PC Pro mode setting, confirm that the ePro’s Protect Mode status is in Normal Mode. If the unit is in Protect Mode the new mode selection will NOT be saved but will be in effect until the unit is restarted. On power-up the ePro will revert back to the saved setting (see Chapter 4 for more information about Protect Mode).

The PanelMate PC Pro Mode is selected by using the Toggle PanelMate PC Pro Mode program.
To activate the program, click Start>Programs>ePro Tools>Toggle PanelMate PC Pro Mode and follow the prompts. If you change the PanelMate PC Pro Mode you must also change the Matrix Mode selection (see next section for details).

Note: For proper operation, Matrix Mode must be ON when the PanelMate PC Pro is in Keypad Mode and Matrix Mode must be OFF when the PanelMate PC Pro is in Mouse Mode.

**Matrix Mode Selection**

Before changing the Matrix Mode setting, confirm that the ePro’s Protect Mode status is in Normal Mode. If the unit is in Protect Mode the new Matrix Mode selection will NOT be saved but will be in effect until the unit is restarted. On power-up the ePro will revert back to the saved setting (see Chapter 4 for more information about Protect Mode).

The Matrix Mode is selected in the TouchPanel Configuration Utility. The PanelMate ePro’s TouchPanel driver loads automatically at bootup and a TouchPanel Driver icon is placed in the system tray in the lower-right corner (by the clock) of the display. In order to change the Matrix Mode selection you must first select the icon in the system tray; doing so launches the TouchKO Touchscreen Driver dialog box. Select the Advanced Settings button and find the Mode On checkbox on the right side. Remove the check to turn the Matrix Mode OFF or add a check to turn the Matrix Mode ON. Next select the Save Settings button or Main>Save Settings and then close the window by selecting the "X" in the upper-right corner of the window. Do not select the Main>Exit menu option as that will close the driver requiring you to reboot the ePro.

Note: For proper operation, Matrix Mode must be ON when the PanelMate PC Pro is in Keypad Mode and Matrix Mode must be OFF when the PanelMate PC Pro is in Mouse Mode.

**Run Mode**

The online system performs three basic tasks

- Screen Updating
- Alarming
- Remote Operations

For more information on screen updating, refer to the Refresh Graphics section or the Conditional Visibility section.

During the Run mode, up to four separate scans may occur. All can be scanned at a user-specified rate. The scans are

- Screen Scan
- Alarm Scan
- Message Scan
- Trend Scan
Proper Run mode operations only occur if a programmable controller or other intelligent device is properly communicating with the ePro. If errors occur, see the Errors During Run Mode section. In Run mode, a variety of operations can take place. Some operations are related to the display functions of the ePro, and some are related to the operator-input functions.

Online Page Layout

Online page layout is flexible. The Configuration Editor lets you determine the online page layout in Run mode. When the Flexible Page Layout field is selected in the System Parameters–General Tab dialog box, it enables you to select or deselect the Page Status Banner, Default Buttons, Alarm Table, or Cancel Key items in the New Configuration Page dialog box and in the Page Properties dialog box.

When the Flexible Page Layout items are selected, the items appear on the page in Run mode. When the Flexible Page Layout items are deselected, the items are removed from the page in Run mode. For each configuration page, you can decide whether to keep or remove the Flexible Page Layout items.

Note: When the Flexible Page Layout feature is enabled, default buttons are deselected, and templates with button controls are selected. The control buttons appear on the right side of the ePro unless the selected template is located in this area. If the selected template resides in the standard control button area, the control buttons appear in an area not occupied by the selected template.

You can select the control button group and move it to a more desirable location by clicking and dragging the button group from the unlabeled one-touch button at the top of the group.

The online page layout is described below.

Page Number and Page Title

The top line displays the page number and the page title of the currently displayed page. It also displays the time of day in 24-hour format (the time is displayed in the CANCEL key.) Additionally, the status of Password A and Password B are displayed on the line by the letters A and B respectively. The letter is displayed if the password is valid for operator entry.
Pages in Alarm

The second line shows only the pages in alarm. The ePro uses the First-In-First-Out (FIFO) method to show only the most recent 10 pages in alarm. If no pages are in alarm, then no page numbers are displayed. If a page is in alarm, you can go directly to that page by selecting the page number.

Alarm Window

The Alarm Window area shows the alarms that you have received. The Alarm Window displays four alarms. If there are more than four alarms, the ePro uses the First-In-First-Out (FIFO) method to show only the latest alarms received. If there are no alarms, the Alarm Window is blank.

Refreshing Graphics

To refresh dynamic objects that overlap other static or dynamic objects appearing on a PanelMate screen, the Refresh Affected Graphics Online field must be selected for the dynamic object you are configuring. When the Refresh Affected Graphics Online field is selected, other objects that lie within the area of the item being updated are redrawn to properly reflect the layering of each object’s draw order on the page when the item is updated.

For example, the following template and object are displayed on the online ePro screen.

![Readout Template](image1)

If the Readout Template is updated and the Refresh Affected Graphic Online field is not selected, the screen appears as shown below.

![Readout Template Updated](image2)
If the Readout Template is updated and the **Refresh Affected Graphic Online** field is selected, the screen appears as shown below.

![Readout Template](image)

**Conditional Visibility**

All templates, variable-sized templates, symbols, and text objects can be visible at all times or only visible based on a condition. When creating a template, variable-sized template, symbol, or text object, you have the following options:

- If the **Enable Conditional Visibility** field is not selected for the template, variable-sized template, symbol, or text object that you are configuring, the item is visible at all times and all updating of the item is activated when in Run mode.

- If the **Enable Conditional Visibility** field is selected and the Visibility Expression evaluates to be true for the object that you are configuring, the item is displayed and all updating of the item is activated when in Run mode.

- If the **Enable Conditional Visibility** field is selected and the Visibility Expression evaluates to be false for the object you are configuring, the item is not displayed and all updating of the item is deactivated when in Run mode.

When objects are activated or deactivated as a result of the Visibility Expression changing, the item is drawn or erased accordingly. If you want the layering of objects to be maintained, you must select the **Refresh Affected Graphics Online** field for the item you are configuring. Refer to the **Refresh Graphics** section for more information.

**Default Control Buttons**

The default control button labels appear when the system powers up in Run mode, when the **CANCEL** button is pressed, when operator input is completed, or when the automatic cancel feature takes effect.
The following table describes the default control buttons that appear when your ePro unit powers up in Run mode.

<table>
<thead>
<tr>
<th>Default Control Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Fault Relay</td>
<td>This control button resets communication errors between the ePro and the PLC or other communication device. Note: There is no physical fault relay.</td>
</tr>
<tr>
<td>View or Acknowledge Alarms</td>
<td>Refer to the Viewing or Acknowledging Alarms section for more information about viewing or acknowledging alarms.</td>
</tr>
<tr>
<td>Get Page</td>
<td>This control button enables you to get a specified configuration page. Refer to the Get Page section for more information about getting a page.</td>
</tr>
</tbody>
</table>

**Get Page**

This control button displays one of the following touchscreen keypads, to allow for numeric entries. When using a TouchPanel unit, numbers are entered using the numeric keypad.

**Notes:**
- Refer to the Alarm Summary Page section for more information about getting the alarm page.
- Refer to the Directory section for more information about the directory.
• Press the **Switch to Two-Column Keypad** template or the **Switch to Three-Column Keypad** template on the Setup Page to switch between keypads. Refer to the Switch to Two Column Keypad or Switch to Three Column Keypad section in the Setup Page section for more information.

If you press the **More** control button on the touchscreen keypad, the following control buttons appear:

![Maintenance Template]

![Change Online Labels]

![Setup Page]

**Notes:**

- Refer to the Maintenance Template section for more information about the maintenance template. Note that the Maintenance Template control button only appears if a maintenance template is allowed on the page.

- Refer to the Change Online Labels section for more information about the system online labels. Note that the Change Online Labels control button only appears if any of the system online labels have been changed and the user can toggle between the standard and user-defined labels.

- Refer to the Setup Page section for more information about the setup page.

**Using the Get Page Control Button**

The first page to appear when you enter Run mode is Page 0, unless you have defined a different start-up page when editing the Startup Page Number field in the Systems Parameters - General Tab dialog box.

From the default control button selections, select any other page by performing the following tasks:

1. Press the **Get Page** control button. The control button labels change.

2. Press the **Directory** control button to access a page title directory.

3. On the numeric keypad, press the number of the page you wish to select. (Note that if you are entering a single-digit page number, the number must be preceded by a zero, for example, 01.) The new page appears immediately. If you press the number for the page you are already on, the page is not re-drawn.

4. Press the **CANCEL** key to remain on the current page and return the control buttons to their default labels.
Note: The Variable-Sized control buttons, and the Remote Page Changing and Pages In Alarm features (located in the page banner) are other ways of getting/changing pages.

Remote Page Selection

The ePro can monitor a register in the process control device and change the page shown on the screen automatically.

The Page Change Register field (described in the Systems Parameters - Remote Tab dialog box section) holds the register number in the process control device, which is monitored by the ePro. When a valid page number is placed in this register via process control device logic, if a control variable-sized template or control template is not selected in the current page, that page is called and is displayed on the screen. If control is selected for an item, once control is relinquished, the page referenced in the register is called and is displayed on the screen.

Note: If the Allow Immediate Page Change field in the Systems Parameters—General Tab dialog box is enabled, the page changes immediately regardless if control is selected.

Directory

The ePro automatically creates a directory of the page titles as you configure your system. If you need to refer to this list of page titles while in Run mode, press the Get Page control button from the default control button selections. The control button labels immediately change. Press the Dir (Directory) control button to view the directory.

To go to a page, press any page number in the entry keypad. To exit the directory, press the CANCEL key.

Note: Highlighting a page in the directory listing only cancels the directory. It does not take you to the selected page.

Up to 200 directory pages can be viewed for your configuration.

Operator Input

Operator input may be one-touch or two-touch depending upon your configuration and hardware model.

One-Touch Selection of Variable-Sized Templates

One-touch selection is available only when you have selected Direct Select on the System Parameter—General Tab dialog box.

Note: ePro TouchPanel configurations must not have the “Direct Select” checkbox checked when operating in Keypad Mode with Matrix Mode ON.

With one-touch selection, a template is selected immediately when you touch it. If the template requires control button input, the corresponding control button labels appear when the template is selected. If no selection is wanted, press the CANCEL key.
Two-Touch Selection of Variable-Sized Control Buttons

Two-touch selection of variable-sized control buttons is required when Direct Select is not checked on the Systems Parameters–General Tab dialog box. Two-touch operation requires at least two keystrokes.

Selecting a Template

Before any change can be made to a template, that template must be selected. To select a template, press the template to move the white box cursor to the location of the template on the screen.

If the template requires control button input, the corresponding control button labels appear when the template is selected. Press the appropriate control button.

If the wrong template is selected before the control button is pressed, simply use the selection keypad to make the right choice. If no selection is wanted, press the CANCEL key.

If the template requires numeric keypad input, the Change Value control button appears when the template is selected. The control button labels immediately change to read Clear and Enter New Value. Use the numeric keys to write the value onto the screen, then press the Enter New Value control button to transmit the value to the process control device. If the wrong number is written before the control button is pressed, simply press the Clear control button and try again. If no selection is wanted, press the CANCEL key.

When variable-sized templates or graphics are used, and Direct Select is not checked in the System Parameters Table, a given template cell area may contain more than one control point. When the TouchPanel is initially touched, the first control point that lies within the template cell area is selected, and is identified by its flashing control indicator. Pressing the same area again steps to the next variable-sized template in a top-to-bottom, left-to-right search pattern within the cell area. The selection process cycles and recycles through all the variable-sized templates with controls lying within the selected cell area.

With Direct Select is not checked, the cell areas referred to here are the screen areas which correspond to the location of 15 single-wide Indicator or Readout templates placed in a 3x5 matrix in the drawing window below the alarm area and to the left of the default control buttons.
Variable-Sized Control Button Operation

The ePro's variable-sized control buttons provide several types of input as defined by the configuration, and they are described in the table below:

<table>
<thead>
<tr>
<th>Control Button/Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normally Open Momentary</td>
<td>When this button is pressed, the ePro sends a command to the process control device to set the referenced bit to a 1. When the button is released, a separate command is sent to set the bit to a 0, thus providing a momentary input to the process control device.</td>
</tr>
<tr>
<td>Normally Closed Momentary</td>
<td>When this button is pressed, the ePro sends a command to the process control device to set the referenced bit to a 0. When the button is released, a separate command is sent to set the bit to a 1, thus providing a momentary input to the process control device.</td>
</tr>
<tr>
<td>Normally Open Maintained</td>
<td>When this button is pressed, the ePro sends a command to the process control device to set the referenced bit to a 1. This state is maintained when the button is released.</td>
</tr>
<tr>
<td>Normally Closed Maintained</td>
<td>When this button is pressed, the ePro sends a command to the process control device to set the referenced bit to a 0. This state is maintained when the button is released.</td>
</tr>
<tr>
<td>Toggle</td>
<td>When this button is pressed, the ePro sends a command to the process control device to set the referenced bit to its opposite state. This state is maintained when the button is released.</td>
</tr>
<tr>
<td>Page Change</td>
<td>When this button is pressed, the page is called.</td>
</tr>
</tbody>
</table>

Alarms

The alarm conditions that you designate in the ePro's template editors are constantly monitored. When an alarm condition occurs, an alarm message is automatically configured by the ePro and drawn in the 4-line alarm window. The same message also goes to a printer if you have configured a printer in the **PLC Name and Port Table** dialog box.
The alarm message always includes the:

- Device name or alarm device name
- Nature of the alarm (high alarm, low alarm, or the alarm condition label)
- Time of the event being reported
- Page for which the device is displayed in the ePro

Additionally, the following attributes also apply to alarm messages, depending on the condition being reported:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New alarms</td>
<td>Alarms are displayed as white text on a red background.</td>
</tr>
<tr>
<td>Acknowledged</td>
<td>Alarms are displayed as yellow text on a black background. The abbreviation &quot;Ackd&quot; appears in the message in front of the time.</td>
</tr>
<tr>
<td>Cleared, not acknowledged</td>
<td>Alarms are displayed as red text on a white background. The abbreviation &quot;Clrd&quot; appears in the message in front of the time.</td>
</tr>
<tr>
<td>Cleared and Acknowledged</td>
<td>The message will disappear from the screen. The message that gets sent to the printer includes the abbreviation &quot;Clrd&quot; in front of the time.</td>
</tr>
</tbody>
</table>

Note: The four most recent alarm messages appear in the alarm window of the current page.

**Alarm Summary Page**

The ePro automatically creates the Alarm Summary Page as alarm conditions occur. In the ePro, the 100 most current alarm messages can be viewed on the Alarm Summary Page at any time. As new alarms occur, the oldest alarms are removed. For example, if 100 alarms have occurred and then one more occurs, the oldest alarm is removed and the new alarm is added to the beginning of the Alarm Summary Page. The page indicator for the page that contains the removed alarm still blinks until the alarm condition has been cleared.

To get to the Alarm Summary Page, press the Get Alarm Page control button from the default control button selections. The Alarm Summary Page appears immediately, displaying the 26 most current alarm messages. If there are no alarm messages to display, the page is blank.

To view the alarms beyond the 26 most current, use the Scroll Up and Scroll Down control buttons. These buttons move a small, white block cursor that marks the start of a specific alarm message. When the block cursor is scrolled down past the last message on the screen, the messages beyond 26 appear. This block cursor is also used to mark individual alarm messages for acknowledgment.
To return to any other page in the system, press the **Get Page** control button and enter the page number using the numeric keypad.

### Viewing or Acknowledging Alarms

To acknowledge alarms in the alarm window located on each page, press the **View or Acknowledge Alarms** control button from the default control button selections. The control buttons immediately change and a small, white block cursor marks the most current alarm, located at the top of the alarm window.

To acknowledge alarms in the Alarm Summary Page, press the **View or Acknowledge Alarms** control button. The control buttons immediately change and a small, white block cursor will mark the most current alarm, located at the top of the page.

The following control button labels appear:

- **Scroll Up**
- **Scroll Down**
- **Acknowledge Selected Alarm**
- **Acknowledge All Alarms**

#### Acknowledging a Single Alarm

To acknowledge a single alarm, move the block cursor using the **Scroll Up** or **Scroll Down** buttons to mark the alarm. Then press the **Acknowledge Selected Alarm** control button to acknowledge.

#### Acknowledging All Alarms

To acknowledge all new alarms, press the **Acknowledge All Alarms** control button. It does not matter where the block cursor is located. This action acknowledges all new alarms, whether they are actually in view or not.

#### Acknowledging Alarms Remotely

Alarms can also be acknowledged remotely. Once the **Remote Alarm Acknowledge Bit** (defined in the **Systems Parameters–Remote Tab** dialog box) is set, all alarms
must be acknowledged. When the **Remote Alarm Acknowledge Bit** is configured, the ePro is also capable of setting a bit in the process control device when the **Acknowledge All Alarms** control button is pressed. This capability, along with the ability to remotely acknowledge all alarms, can be useful in allowing one operator to acknowledge from a single system all alarms on a network of ePros.

### PanelMate PC Pro Password Protection

Passwords can be used to restrict access to certain functionality when the ePro is in Run mode. The ePro supports multiple levels of password protection, but does not use the Windows NT password functionality. Password protection works like this:

A great deal of flexibility is provided so it is important to define an implementation scheme before configuring your passwords. There are two levels of protection: **Password A** and **Password B**. Passwords A and B are configured in the **System Parameters–Password Tab** dialog box and are up to 5 digits in length. Passwords can be enabled or disabled to permit or prohibit change during online operation.

Passwords are numbers that range between 0 and 65535.

**Note:** Leading zeroes are not supported when configuring **Password A** and **Password B** in the **System Parameters - Password Tab** dialog box.

### Templates with Numeric Entry Selected

You can use passwords in the following areas in the Run mode. They must be enabled for entry each time they are selected.

- Readout Template
- Variable-Sized Readout Template
- Bar Template
- Variable-Sized Bar Template
- Table Template
- Close PanelMate Application
- Maintenance Template
- Set Date and Time

The following combinations of Password Protection are available:

- None
- Password A or B
- Password A Only
- Password B Only

**Note:** PanelMate ePro or PC Pro does not support a keyswitch. The keyswitch and combinations of keyswitch/passwords listed in the Configuration software are there to support other versions.
Password protection can also be invoked to protect access on a Page-by-Page basis. Once a Page Password is logged-in, access to a page remains active until it is logged-out. While logged-in, the operator can change pages and return to this page until logged-out. Password A and B can be logged-out manually or a user-defined time period can expire which logs-out all passwords. If the time-out occurs, the operator retains access to the current page.

Page Passwords are accessed in the Setup Page. This page is accessed from the default page by selecting the Get Page, More buttons and Setup Page control buttons. The letters A and B appear to the left of the time of day clock on the top line of each page to indicate when Password A, and/or Password B are enabled for entry. The status of the passwords, when used as Page Passwords, may be transmitted to a process control device by setting the appropriate address in the System Parameters–Password Tab dialog box. This feature can be useful when implementing the Page Protection concept when a Page Change is sent from a process control device.

Passwords A and B are downloaded within the User Configuration to the ePro. These values may be used at system start-up or they may be defined to overwrite current passwords that reside in the system.

Password Protection can be implemented in many ways. Examples of usage are defined below:

- Close PanelMate Application protected with Password A
- Set Date and Time protected with Password B
- Reset Part Counter Readout Template protected with Password A and Password B

**Lost PanelMate ePro or PC Pro Password Recovery**

You cannot determine the passwords in a PanelMate PC Pro system, but you can recover a password that is lost. There are three ways in to recover a password:

1. If the User Configuration has the Overwrite Password fields selected, simply reinstall the configuration. Reinstallation resets the system to the original passwords defined in the configuration.

2. If the User Configuration does not have the Overwrite Password fields selected, you must use the Configuration Software to modify the configuration. Select the Overwrite Password fields, enter the new passwords, and reinstall the new configuration.

3. If the first two methods fail, you can reset the passwords by deleting the file “c:\WINNT\MPAPPS\PMNT.ss” and then rebooting.

**Setup Page**

Setup Page is accessed from the default control buttons. This page allows for the selection of the following features while the ePro remains in the Run mode.
To access a feature, select a template then press the **Execute** control button.

**Note:** The **Cleaning Mode** and **Switch to Two Column Keypad** buttons only appear on touchscreen units.

### Change Password A or Change Password B

This selection allows you to change a software password. You are prompted to Enter the Old Password, Enter the New Password, and then Re-enter the New Password. If the ability to change the passwords in the online mode is not desired, do not enable the **Allow Password A Change** field or the **Allow Password B Change** field in the **System Parameters - Password Tab** dialog box.

### Log-in Password A and Log-in Password B

These selections allow you to log-in a valid page password. The password remains enabled until you log-out or the Page Password Time-out period expires.

Refer to the **Password A** and **Password B** sections in the **Systems Parameters - Password Tab** dialog box section for information on configuring passwords.

### Set Date and Time

This selection allows you to enter the **Set Date** or **Set Time** field. Use the numeric keypad to enter the appropriate value. Use the minus key to separate numeric values.

**Notes:**

- The time is entered in 24-hour (military) format.
- This selection can be password protected.
Log-out Password A and Log-out Password B

These selections permit you to Log-out of a page password by pressing the Execute control button.

**Note:** The Log-out Password A template or Log-out Password B template only appear on the Setup Page if you have logged-in password A or password B.

Display System/Configuration Information

This selection displays the current User Configuration, Executive Firmware, and Installed Drivers.

Close PanelMate Application

This selection closes the currently running PanelMate PC Pro configuration. The normal Windows NT desktop appears.

Cleaning Mode (Available Only on Touchscreen Units)

This selection allows you to clean your touchscreen.

Switch to Two Column Keypad or Switch to Three Column Keypad (Available Only on Touchscreen Units)

This selection switches between the two-column and three column numeric entry keypads.

**Notes:**

- When the two-column keypad is displayed, the button indicates “Switch to Three Column Keypad.”
- When the three-column keypad is displayed, the button indicates “Switch to Two Column Keypad.”

For more information about the two column or three column keypads, refer to the Default Control Buttons section.

Maintenance Templates

**Note:** To use the Maintenance Template online, you must configure the Allow on Page selection in the New Configuration Page dialog box or in the Page Properties dialog box within the Configuration Editor.

To access the Maintenance Template online, you must press the Get Page control button from the default control buttons online, press the More control button and then press the Maintenance Template control button. The Maintenance Template selection cursor appears in the upper-left corner. You can place the Maintenance Template on any cell including cells already occupied by a fixed template or another Maintenance Template. You cannot place a Maintenance Template on top of a variable-sized template.
Note: The Maintenance Template does not appear on your page until you press the Activate control button. (The default process control device name appears in the Maintenance Template.) If you press the Deactivate control button, the Maintenance Template is removed from your page.

Once the Maintenance Template is activated, press the CANCEL key and re-select the Maintenance Template. The Deactivate and Modify Template control buttons appear.

Notes:

- When selecting a template cell to place a Maintenance Template, static values are displayed in the template’s value fields if the ePro is not communicating to the process control device.
- The Maintenance Template does not work with OPC Server drivers.

Refer to the Maintenance Template Examples for more information.

Start Monitor

This control button label toggles between Start Monitor and Stop Monitor. With this control button, it is possible to freeze a value for prolonged observation.

Note: When you press the Start Monitor control button and the Enable Writes field in the New Configuration Page dialog box is configured on the page and the Maintenance Template is configured with a valid reference, the Change Value control button also appears.

Deactivate

This control button deletes the Maintenance Template from the page.

Change Value

This control button is displayed only if the Enable Writes field in the New Configuration dialog box or the Page Properties dialog box was configured for the page. This control button changes the display and opens a data entry field to permit the operator to enter a value. If Password Protection has been configured in the New Configuration dialog box or the Page Properties dialog box for the pages that contain Maintenance Templates, the operator is prompted before data entry is permitted.
Modify Template

This control button is used to change the configuration of the Maintenance Template. This control button changes the display and calls three control buttons. The control buttons are Change PLC Name, Change PLC Ref, and Data Format. The operator may change one or all of the three entry variables (name, reference, format).

When the Maintenance Template is configured with a valid reference, the Start Monitor control button appears. Once you are satisfied with the changes, you must press the Start Monitor control button. This advises the ePro to check the name, reference, and format to determine if they are valid, and if valid, begin to read that information.

If the reference is invalid, an error is displayed on the error line on the bottom of the page and the reference is cleared.

Change PLC Name

The online selection of the process control device Name occurs in the Change PLC Name control button. The default process control device Name is displayed in the data entry field. Use the Previous or Next control buttons to scroll through the list of names entered in the PLC Name and Port Table dialog box.

Once you press the Change PLC Name control buttons, three buttons appear, labeled Previous, Next, and Accept.

Change PLC Ref

The online selection of the process control device Register Reference occurs in the reference field of the template. The operator must know the correct alpha and numeric characters to enter to access the memory of the process control device to which it is communicating.

See your PanelMate Power Pro Communications driver documentation for more information. If the process control device brand uses numbers only, the numeric keypad may be used to enter the address. If the process control device brand requires characters other than numeric, then the Previous, Next, and Clear buttons serve a special purpose. The Previous and Next button are used to determine the operation of the Clear button, which becomes a “hot key”. The functionality of the hot key can be changed by using the buttons labeled Previous and Next.
The hot key can assume the following functionality:

<table>
<thead>
<tr>
<th>Touchscreen Hot Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;&gt;</td>
<td>Moves the entry cursor one character right.</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Moves the entry cursor one character left.</td>
</tr>
<tr>
<td>DEL</td>
<td>Deletes the character at the current cursor position.</td>
</tr>
<tr>
<td>SPACE</td>
<td>Places a blank space at the current cursor position.</td>
</tr>
<tr>
<td>CLEAR</td>
<td>Clears the entire entry field.</td>
</tr>
<tr>
<td>SEL</td>
<td>Enters the mode to select alpha character strings.</td>
</tr>
</tbody>
</table>

In Change PLC Reference mode, the hot key labeled Clear is displayed. Selecting the Previous button changes the hot key to Space, while selecting the Next button changes the hot key to Select.

In Select mode, the first of a list of alpha characters for the currently selected process control device name is displayed in the data entry field. Selecting the Next button moves deeper into the alpha character list while selecting Previous button takes you back to Clear. Once in the Select mode, the Previous and Next keys scroll through the alpha character strings that are required to address the process control device brand associated with the process control device name currently selected.

Once the correct character string is displayed, you may press the Select hot key to lock in that character. Alternately, you may press a numeric key that locks in the alpha key and enter a number. Pressing the numeric key reduces the number of keystrokes and permit faster entry. Do not press the Accept button until the entire address is entered or an error may occur.

The operator uses a combination of hot key entry and numeric entry to enter the address for the process control device. The hot key may also be used to edit an existing address without requiring complete re-entry of the address. Refer to the Maintenance Template Examples for more information.

**Maintenance Template Examples**

*Example 1: Entering a new address.*

To enter the Allen-Bradley Reference N7:10, complete the following steps:

1. Select the Maintenance Template.
2. Press the Modify Template control button.
3. Press the Change PLC Ref control button.
4. Press the Next button. This places the hot key in the Select mode.
5. Press the Next button until an "N" appears in the entry field.
7. Press the **Next** button until the colon appears in the entry field.
8. Use the numeric keyboard. Press <1>, then press <0> to enter 10.
9. Press the **Accept** button to enter the address.
10. Press the top **Start Monitor** control button to begin reading that address.

**Example 2: Editing an existing field.**

To change the Allen-Bradley Reference N7:10 to N7:20, complete the following steps:

1. Select the Maintenance Template
2. Press the **Modify Template** control button.
3. Press the **Change PLC Ref** control button. The cursor appears at the far right of the entry field.
4. Press the **Previous** button. This places the hot key in the Space mode.
5. Press the **Previous** button. This places the hot key in the Delete mode.
6. Press the **Previous** button. This places the hot key in the Cursor Left mode.
7. Press the **Cursor Left** Hot Key. The hot key moves the cursor from the far right onto the 0.
8. Press the **Cursor Left** Hot Key. The hot key moves the cursor from the 0 onto the 1.
10. Press the **Accept** button to enter the address.
11. Press the top **Start Monitor** control button to begin reading that address.

**Data Format**

The register can display in one of these formats: NUM, BITS, or HEX.

If NUM is selected, the data displays in a numeric format. The ePro automatically type casts information based upon the memory area of the process control device that is read. This means it manages integer, BCD, and binary data types and displays them as numbers. Numeric entries are converted to the correct data type and sent to the process control device if the **Enable Writes** field is configured in the **New Configuration Page** dialog box or in the **Page Properties** dialog box.

If BITS is selected, the data is entered and is displayed in a binary bit pattern for the register selected. If the process control device word contains 16 bits, then the display shows two 8 bit bytes. The sequence is high byte above low byte and high bit to the left, low bit to the right. The bit values are not manipulated to any data format. The operator accepts responsibility for entering a legal bit combination (for example, writing 1111 to a BCD digit is an illegal value).

If HEX is selected, the data is entered and is displayed in hexadecimal format (0-9 and A-F) of the bit pattern for the register selected.
Sixteen bit values are displayed in four-digit HEX representation.

**Example:** 0023 HEX is written to the process control device as 0000 0000 0010 0011. It is not converted to a 35 decimal or 0000 0000 0100 0101 in binary.

Only NUM types are converted to the numeric value based upon the memory areas of the process control device referenced.

The figure below shows an example of a 16-bit word in a Maintenance Template with the Bits format selected.

![Diagram of a 16-bit word in a Maintenance Template with Bits format selected.](image)

**Notes:**
- The Maintenance Template does not support 32-bit registers (such as, #S32, #U32, #BIN6, #BIN8, #BCD8, #BCD6, and #FP).
- The Maintenance Template does not support unsolicited references.
This chapter describes PanelMate ePro troubleshooting. The following topics are discussed:

- Errors during run mode
- Communication errors
- System errors
- Error codes
- Interface card errors
- Runtime issues
- Checking user configuration compatibility
- ePro troubleshooting
- ePro event viewer
- Replacing the fuse
- Calibrating the touchscreen
- Calibrating the TouchPanel
- Using a mouse in Run mode
- Placing the PanelMate ePro in Protect Mode
Errors During Run Mode

During Run mode operation, two basic conditions are checked:

- Proper communications with process control device or other communication interfaces, such as a DDE server
- Proper operation of the Runtime software

If there is a process control device or host computer problem, the error is classified as a **Communication Error**. The two types of Communication Errors are local errors and remote errors.

If there is an Executive Firmware problem, the error is classified as a **System Error**.

Refer to the **Error Codes** section for a list of error codes and their descriptions.

Communication Errors

The ePro can interface with a single process control device or with multiple process control devices. It provides predictable fault responses with the occurrence of communication errors that indicate a breakdown in communication between the ePro and a process control device. It is the Control System Designer's responsibility to define how the operator should respond to an error.

The ePro provides two indications when a communication error occurs:

- An error message is written to the bottom of the screen
- The fault relay is de-energized

The fault relay is provided for both local annunciation to an operator and to send hardwired feedback to a process control device.

Once a communication error occurs, the operator should first note the page status. The data is a snapshot in time of the last valid communication. The next action is to try to clear the error by pressing the **Enable Fault Relay** control button, which is an attempt to restart communications. If the condition causing the error no longer exists, the screen is updated with dynamic information. If the error remains, the communication error message is written to the screen. If values could not be communicated due to the lack of communications, then templates are displayed as blank.

**Warning:** If blank templates appear on the screen, it means that communications have not been re-established. The operator should not attempt to perform control with blank templates because the actual state of the machine or process cannot be determined. If the operator continues to press control buttons, data may be sent faster than the communication link that is in error can handle them.

The ePro buffers the control requests until communications have re-established. This function may result in control bits being sent to a process control device in rapid succession that may cause undesirable operation of the control system.

**Caution:** When running in Unsecure mode at 640x480 resolution, communication errors are hidden by the Windows frame and are not viewable on screen. You must use 800x600 or higher resolution (not available in ePro models) or Secure mode to view communication errors.

Communication errors can be cleared by pressing the **Enable Fault Relay** control button or changing pages, provided the reason for the error no longer exists. Integrity of the communication...
link to the process control device (or host) is monitored by ensuring that proper responses are received for each transmission that the ePro makes, according to the specific protocol in use.

Communication problems can include:

- Broken or incorrect cabling to the process control device
- Process control device or interface card failure
- Incorrect setting of process control device interface card switches
- Removal of a process control device from the active network
- Attempt to access a non-existent process control device address
- Attempt to write to a protected process control device address
- Too much traffic on a process control device network

The ePro tries to re-transmit a request several times before reporting that a communications error has occurred. Unlike Systems Errors, Communication Errors do not halt the system. The ePro continues to re-transmit requests indefinitely, even after an error has been reported.

The frequency of the re-transmission gradually decreases to five minutes if requests continue to fail over a prolonged period of time. This feature effectively prevents failing requests from conflicting with other communications.

Refer to the Error Codes section for a list of error codes and their descriptions.

Local Errors

Local errors are reported on the bottom of the screen as follows:

```
Loc:  X  on  N  via  P  O  R
```

where:

- \( X \) is an internally generated communication error code that indicates the nature of the problem. Refer to the Error Codes section for a list of error codes and their descriptions.
- \( N \) is the device name in the PLC Name and Port Table.
- \( P \) is the port.
- \( O \) is the operation being performed.
- \( R \) is the reference.

Remote Errors

Remote errors are reported on the bottom of the screen as follows:

```
Rem:  X  on  N  via  P  O  R
```

where:

- \( X \) is a generated communication error code from a remote device. Refer to your process control device user manual for more information on this error code.
N is the device name in the PLC Name and Port Table
P is the port
O is the operation being performed
R is the reference

Note: If you are using Allen-Bradley PLCs for Data Highway or Data Highway Plus, a complete set of error codes can be found in the Allen-Bradley Publication 1770-6.5.16, November 1991. Take note of the hexadecimal error code and consult the Allen-Bradley publication. If the remote error code is F0XX (hex), then the XX represents the Allen-Bradley EXT STS (extended status) error code. The EXT STS codes are found in the EXT STS Codes for Command Code 0F (hex) table. Other remote error codes are found in the Remote STS Error Codes table.

When a communication error is reported, the system continues to operate. Other communication device transmissions are attempted and processed. Transmissions that have failed are re-attempted until normal communication is re-established. Each time the error is detected, the message is reprinted at the bottom of the screen.

The data at the time of a communication failure remains on the current page. If a different page is selected, no data from the communication device with errors is shown. For example, if the page contains a readout template, no numerical data from the device with the communication errors is shown. The numerical area is blank. All data from other devices that are operating correctly display as usual.

Once the communications problem is corrected and the Enable Fault Relay control button is pressed, the page is re-drawn. Templates or Variable-Sized Templates that reference a process control device that is not communicating are not re-drawn until valid communications resume.

After the error is corrected, the error message remains until the operator presses the Enable Fault Relay control button, which appears on the default selections when a communications error occurs. Pressing this button clears the message from the bottom of the screen. (The button label disappears once the button has been pressed.)

Note: Invalid information may still be displayed. For example, if an expression for a Variable-Sized Bar Template value contains a reference to a process control device that is communicates, and also contains a reference to a process control device that is not communicating, the Variable-Sized Bar Template is updated on the screen, even though invalid data may be in the database.

Refer to the Error Codes section for a list of error codes and their descriptions.
System Errors

During Run mode operation, proper operation of the system software is checked.

Proper operation of system software is monitored to ensure that all internal processes are active and functioning normally. If a system software error is detected, an exception error is reported in a Dr. Watson diagnostic window and the PanelMate PC Pro configuration halts.

As shown below, a typical error message lists the name of the application, type of error, and the address.

Note: If these error messages appear, check your configuration for illegal or missing references.

Error Codes

For error code descriptions, refer to the table below.

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Undefined error.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Software module not found or corrupted.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Out of memory.</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Bad or missing communication card.</td>
<td></td>
</tr>
<tr>
<td>244-246</td>
<td>Read/write error.</td>
<td>• Cabling wrong.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• RS232/RS422 converter bad or missing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Excessive noise on communication line.</td>
</tr>
<tr>
<td>Error Number</td>
<td>Description</td>
<td>Possible Cause</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| 253          | Acknowledge not received from the remote device or remote device did not reply to request in allotted amount of time. | • No communication.  
• PLC busy.  
• Invalid network ID.  
• Wrong communication parameter.  
• PanelMate unit may be receiving too many unsolicited messages. |
| 1000         | Internal system error code. | • Invalid configuration.  
• Bad PLC Name and Port Table. |
| 1001         | Serial port buffer overrun. | • PLC locked in transmit mode.  
• PLC transmitting too much data. |
| 1002         | Error on input. | • Wrong communication parameters.  
• Intermittent hardware failure. |
| 1003         | Error on output. | • Wrong communication parameters.  
• Intermittent hardware failure. |
| 1100         | Device descriptor cannot be generated. | • Out of memory.  
• Module not found. |
| 1101         | Device cannot be opened. | • Missing module.  
• Serial controller or I/O board bad.  
• Missing or bad hardware.  
• Interface board not installed. |
| 1102         | Expected data was not received. | • Communication established. The PanelMate unit started reading data but timed out.  
• Error 1102 is usually followed by a 1202 or 1702 error. |
<p>| 1127         | Overrun error. | Wrong communication parameters, no communication. |
| 1128         | Hardware break. | Grounding, shield, or termination problem. |
| 1150         | Data Highway, Data Highway Plus, and AcceleratI/On error - the AcceleratI/On card has detected an error during its memory diagnostics. | |</p>
<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>1151</td>
<td>Data Highway, Data Highway Plus, and AcceleratI/On error· the AcceleratI/On card would not restart.</td>
<td></td>
</tr>
<tr>
<td>1151</td>
<td>DH-485· destination buffer not big enough to receive message</td>
<td></td>
</tr>
<tr>
<td>1152</td>
<td>DH-485· message too big to transmit.</td>
<td></td>
</tr>
<tr>
<td>1153</td>
<td>Data Highway, Data Highway Plus, and AcceleratI/On error· the AcceleratI/On card has no transmit buffers available.</td>
<td>AcceleratI/On card receiving unsolicited data (MSG's) too fast.</td>
</tr>
<tr>
<td>1153</td>
<td>DH-485· received NAK from destination.</td>
<td>Normally received if destination has too many outstanding requests.</td>
</tr>
<tr>
<td>1154</td>
<td>Data Highway, Data Highway Plus, and AcceleratI/On error· the AcceleratI/On card would not respond to the interface software's command.</td>
<td>AcceleratI/On card hardware failure.</td>
</tr>
<tr>
<td>1154</td>
<td>DH-485· time-out: no response from destination after 3 retries.</td>
<td>Invalid ID or PLC type.</td>
</tr>
<tr>
<td>1155</td>
<td>DH-485· duplicate node detected.</td>
<td>Two devices on highway have same network ID (node #).</td>
</tr>
<tr>
<td>1156</td>
<td>DH-485· link is not active (link time-out) PanelMate unit is not passing token.</td>
<td>Missing or bad cable.</td>
</tr>
<tr>
<td>1156</td>
<td></td>
<td>Noise on communication line.</td>
</tr>
<tr>
<td>1157</td>
<td>DH-485· application time-out (destination active but not responding).</td>
<td></td>
</tr>
<tr>
<td>1158</td>
<td>DH-485· The PanelMate unit has not received token from previous node.</td>
<td>Network communications disrupted. The cable was disconnected from the PanelMate unit or the previous node has dropped off the network. Note: Error 1158 is usually followed by an 1156 error.</td>
</tr>
<tr>
<td>1200</td>
<td>Communication active but remote device responded with negative acknowledge (NAK).</td>
<td>Noise on communication line.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wrong parity.</td>
</tr>
</tbody>
</table>

•
<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
</table>
| 1201         | Communication active but remote device responded with negative acknowledge (NAK). | • Noise on communication line.  
• Wrong parity. |
| 1202         | Acknowledge not received from the remote device or remote device did not reply to request in allotted amount of time. | • No communication.  
• PLC is busy.  
• Invalid network ID.  
• Wrong communication parameter.  
• The PanelMate unit may be receiving too many unsolicited messages.  
• This error is driver dependent. |
| 1203         | PanelMate unit cannot set privilege level in GE PLC (SNP).                    | • Communication error while trying to set privilege.  
• Other device has set privilege. |
| 1203         | PanelMate unit cannot set privilege level in GE PLC (SNP).                    | • Communication error while trying to set privilege.  
• Other device has set privilege. |
| 1250         | Could not establish link with Square D PLC.                                  | • |
| 1250         | Could not synchronize with Westinghouse PLC.                                 | • |
| 1250         | Reliance AutoMate Gateway not configured.                                    | • No communication.  
• PLC is busy.  
• Invalid network ID.  
• The PanelMate unit unsuccessfully trying to reconfigure Reliance gateway module.  
• Dipswitches configured wrong.  
• Power loss to gateway module.  
• Intermittent error. |
| 1250         | Channel prematurely closed by GE CCM.                                         | The PanelMate unit too busy to close channel. |
| 1250         | Communication to GE with SNP out of sync.                                     | • The PanelMate unit too busy to accept reply.  
• Noise or cable problems. |
| 1251         | Open Channel request was refused by GE CCM.                                   | • GE CCM card is too busy to open channel.  
• Noise on communication line to GE.  
• Wrong parity. |
<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>1251</td>
<td>Reliance AutoMate processor not found in destination slot.</td>
<td></td>
</tr>
</tbody>
</table>
| 1251         | PanelMate unit cannot set privilege level in GE PLC (SNP). | • Communication error while trying to set privilege.  
• Other device has set privilege. |
| 1252         | More than one Reliance AutoMate processor in the rack. |                |
| 1700         | Communications out of sync. | Duplicate token, noise, or busy device causes PanelMate unit to time-out and PLC responds to previous request. |
| 1701         | A reply was received for which there was no request issued. | Scan delays too large. |
| 1702         | Acknowledge not received from the remote device or remote device did not reply to request in allotted amount of time. | • No communication.  
• PLC busy.  
• Invalid network ID.  
• Wrong communication parameter.  
• The PanelMate unit may be receiving too many unsolicited messages.  
• This error is driver dependent. |
<p>| 1703         | Internal system error code. |                |
| 1705         | This interface does not support any unsolicited requests from a remote device. |                |
| 1706         | Received an unsolicited command that is not supported. |                |
| 1707         | The remote device memory type is not supported. |                |
| 1708         | Cannot write to read only reference. |                |
| 1750         | Siemens follow-on telegrams are not supported. | PLC sending too much data. |
| 1750         | Block transfer not detected on remote I/O. |                |</p>
<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>1750</td>
<td>Data Highway and Data Highway Plus—does not support PLC-3 address format.</td>
<td></td>
</tr>
<tr>
<td>1750</td>
<td>Generic Protocol octal register reference invalid.</td>
<td></td>
</tr>
<tr>
<td>1750</td>
<td>DH-485—I/O word number out of range.</td>
<td></td>
</tr>
<tr>
<td>1751</td>
<td>Too much data in Generic Protocol.</td>
<td>More than 60 words in data transfer.</td>
</tr>
<tr>
<td>1751</td>
<td>Data Highway and Data Highway Plus—symbolic word and addressing mode is not supported.</td>
<td></td>
</tr>
<tr>
<td>1751</td>
<td>Remote I/O—rack is not active or configured.</td>
<td></td>
</tr>
<tr>
<td>1752</td>
<td>Remote I/O—PLC is in test or program mode.</td>
<td></td>
</tr>
<tr>
<td>1752</td>
<td>Data Highway and Data Highway Plus—symbolic file and addressing mode is not supported.</td>
<td></td>
</tr>
<tr>
<td>1753</td>
<td>Remote I/O—remote rack is in a faulted condition.</td>
<td></td>
</tr>
<tr>
<td>1754</td>
<td>Remote I/O—communications not active.</td>
<td>On a PLC-3 if communications do not recover on the PanelMate unit check the revision of the EPROM on the AcceleratI/On card. The revision must be 05 or greater (P/N 85-00285-05 or 85-00307-05).</td>
</tr>
<tr>
<td>1755</td>
<td>Remote I/O—block transfer count is too small.</td>
<td></td>
</tr>
<tr>
<td>1761</td>
<td>Allen-Bradley error code 01—remote device could not take message.</td>
<td>Not enough memory in an older PLC 5/15 and/or 5/250. Too much traffic on device.</td>
</tr>
<tr>
<td>Error Number</td>
<td>Description</td>
<td>Possible Cause</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1762</td>
<td>Allen-Bradley error code 02—remote device does not acknowledge.</td>
<td>The PanelMate unit is communicating properly on the highway but the remote device cannot be found (Wrong network ID). Remote device is bad or missing.</td>
</tr>
</tbody>
</table>
| 1763         | Allen-Bradley error code 03—unrecognized response from remote device. | • Duplicate token holder detected.  
• General network error. |
| 1764         | Allen-Bradley error code 04—local port is disconnected (Data Highway Plus only). | • Not passing token.  
• The PanelMate unit is disconnected from highway or improperly connected.  
• Noise on communication line. |
| 1766         | Allen-Bradley error code 06—duplicate node detected.             | Two devices with the same network ID (node #). |
| 1767         | Allen-Bradley error code 07—station is off-line.                |                                                                                |
| 1768         | Allen-Bradley error code 08—hardware fault.                     |                                                                                |
| 1774         | Allen-Bradley error code 0E—PanelMate unit received duplicate transaction number. | Communications out of sync. |
| 2000-2002    | Internal system error code.                                      | Driver corrupted (Re-download driver). |
| 2100         | Internal system error code.                                      | Configuration and driver may be incompatible. |
| 2103         | All PLC references in current block are invalid.                | Check all references to same memory area. |
| 2105         | Could not update database via block read.                       | Possible hardware problem.  
Internal data structure corrupted. |
<p>| 2106         | Could not update database via unsolicited request.              | PLC sending unsoliciteds to PanelMate unit memory area that does not exist. |</p>
<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>2107</td>
<td>Remote interface supports only one block read.</td>
<td></td>
</tr>
<tr>
<td>2120</td>
<td>Invalid bit write register.</td>
<td>GE CCM or TI Host Link bit write registers invalid.</td>
</tr>
<tr>
<td>2200</td>
<td>Unsolicited request failed. Connection not established with remote device.</td>
<td>PLC is sending unsolicited data before PanelMate unit is ready to receive it.</td>
</tr>
<tr>
<td>2201</td>
<td>Inconsistent local address.</td>
<td>Network ID does not match interface board ID.</td>
</tr>
<tr>
<td>2500</td>
<td>Invalid separator.</td>
<td>Check PLC references.</td>
</tr>
<tr>
<td>2503</td>
<td>Invalid reference. Cannot parse.</td>
<td>Too many characters in network address or PLC reference.</td>
</tr>
<tr>
<td>2525</td>
<td>Network address component out of range.</td>
<td>Configured Network ID or PLC ID out of range.</td>
</tr>
<tr>
<td>3000-3005</td>
<td>Internal system error code.</td>
<td>• Driver corrupted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Download new executive firmware/drivers.</td>
</tr>
<tr>
<td>3006</td>
<td>Cannot write to unsolicited driver.</td>
<td>A reference associated with a name in the unsolicited device field is being used in a control button or numeric entry field.</td>
</tr>
<tr>
<td>3025</td>
<td>Network address (PLC ID field) is invalid or out of range.</td>
<td></td>
</tr>
<tr>
<td>3050-3055</td>
<td>Internal system error code. Data buffer corrupted.</td>
<td>Baud rate too slow.</td>
</tr>
<tr>
<td>4100</td>
<td>Invalid network ID.</td>
<td></td>
</tr>
<tr>
<td>4101</td>
<td>Invalid network ID.</td>
<td></td>
</tr>
<tr>
<td>4102</td>
<td>Not enough network ID levels specified.</td>
<td></td>
</tr>
<tr>
<td>4103</td>
<td>Too many network ID levels specified.</td>
<td></td>
</tr>
<tr>
<td>4104</td>
<td>Invalid network ID.</td>
<td></td>
</tr>
</tbody>
</table>
## Interface Card Errors

The error codes shown below are associated with interface cards.

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
<th>Possible Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>107</td>
<td>SD card bad port and/or memory address.</td>
<td>Port address does not match the switch settings on interface card. Port address in conflict with other memory in computer.</td>
<td>• Ensure the dip switch settings on interface card match the port address selected. • Select a different port address.</td>
</tr>
<tr>
<td>108</td>
<td>SD card memory error.</td>
<td>SD card memory in conflict with other memory in computer. SD card may be defective.</td>
<td>• Select a different memory setting. • Replace and test with a known good interface card.</td>
</tr>
<tr>
<td>109</td>
<td>SD card processor failure.</td>
<td>SD card may be defective.</td>
<td>Replace and test with a known good interface card.</td>
</tr>
<tr>
<td>10A</td>
<td>SD card error.</td>
<td>SD card may be defective.</td>
<td>Replace and test with a known good interface card.</td>
</tr>
<tr>
<td>10B</td>
<td>SD card software module not found.</td>
<td>Configuration software not properly installed or is corrupt.</td>
<td>Reinstall configuration software.</td>
</tr>
</tbody>
</table>
## Runtime Issues

**Note:** For information on configuration editor or transfer issues, refer to the PanelMate Power Series Configuration Editor User’s Guide or the Transfer Utility User’s Guide.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| Error message:  
“Create Port Failure: The system cannot find the specified file”.  
This message may be followed by another dialog that states “Write comm: The handle is invalid”. | The configuration has assigned a serial communication driver to a serial port that is not available within Windows NT. | • Check Ports and Devices from the Control Panel to ensure serial communications are properly configured.  
• Use the Windows NT Diagnostics (Administrative Tools) to troubleshoot possible conflicts.  
• If you are using a serial mouse, touchscreen, or other serial device, make sure the port is not already assigned. |
| Error message:  
“Can't Create Procedure Pointer to SS_......- the specified module could not be found”. | The configuration is using the Allen-Bradley Data Highway or Data Highway Plus I/O driver and the S&S 5136-SD card is not properly configured. | • Check the installation procedure for the 5136-SD card. If it is properly installed, you should be able to view the driver resources from the Windows NT Diagnostics under Administrative Tools in the Start-Programs menu.  
• Under the Resources tab, I/O Settings and Memory Settings, the SSTechDrvr should appear at the addresses configured during installation (Default: I/O Port: 0250-0257; Memory: 00D0000-000D7FFF). |
| The PanelMate.pps file fails to run or generates an Exception Error when trying to load. | Address reference error in the application. | • Run the verify utility from the Configuration Editor.  
• If this does not find the problem, review all references on the page that is loading when the exception error occurs. Ensure all references are entered correctly. |
### Issue | Possible Cause | Corrective Action
--- | --- | ---
The PanelMate.pps file fails with the error “ReadPLCPortTab: Win Ec\ex failed: error code = 2”. | Associated communication driver is installed incorrectly. | Check the PMCONFIG\NTONLINE directory for the driver’s .exe file. 
Modified PanelMate fonts do not display correctly. | New PanelMate fonts need to be installed on the PC. | Use the Fontmaker utility (CD-Rom\Utility\Tools) to install new fonts on the PC. 

### Checking User Configuration Compatibility

As the PanelMate PC Pro program starts up, it automatically checks for the presence of a valid user configuration. It then verifies the configuration is compatible with the Runtime software version. If the two

- Match—the startup sequence continues. 
- Are incompatible—the following error message is displayed: 

  **PanelMate PC: Incompatible Configuration**

  and installation of new Runtime software or a new configuration is required. Click the **OK** key to cancel.

If you experience other problems during program startup, you should check for the presence of Runtime software and installed drivers.
## ePro Troubleshooting

The following table provides issues, possible causes and corrective actions for ePro troubleshooting.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>At the NTDETECT V4.0 Checking Hardware bootup screen, the ePro stops the bootup process</td>
<td>The keyboard is in the mouse port</td>
<td>Plug the keyboard into the correct port</td>
</tr>
<tr>
<td>The mouse does not work</td>
<td>The mouse:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Is plugged into the keyboard port</td>
<td>• Make sure that the mouse is plugged in, and is plugged into the correct port</td>
</tr>
<tr>
<td></td>
<td>• Is not plugged in</td>
<td>• Make sure that the mouse is in System mode</td>
</tr>
<tr>
<td></td>
<td>• Is disabled</td>
<td>• Use the touchscreen or TouchPanel exclusively when online</td>
</tr>
<tr>
<td></td>
<td>• Conducted and radiated electrical noise is causing the mouse to malfunction when online</td>
<td></td>
</tr>
<tr>
<td>The ePro displays a &quot;DISK BOOT FAILURE, INSERT SYSTEM DISK AND PRESS ENTER&quot; message</td>
<td></td>
<td>Call technical support</td>
</tr>
<tr>
<td>During bootup (and subsequent bootups), a blue screen displays.</td>
<td></td>
<td>Call technical support</td>
</tr>
<tr>
<td>A domain error is received when powering up PanelMate ePro</td>
<td>PanelMate ePro network configuration has been changed from a workgroup setting to domain setting.</td>
<td>Change the PanelMate ePro network configuration settings to workgroup.</td>
</tr>
<tr>
<td>Touchscreen does not work</td>
<td>Logging on with a new account name and/or password</td>
<td>Reboot the ePro</td>
</tr>
</tbody>
</table>
ePro Event Viewer

The Event Viewer is used to log all of the ePro unit’s operating system errors, as well as any errors that are associated with the running of your configuration from the PanelMate PC Pro software.

To view the errors in your Event Viewer, complete the following steps:

1. Click **Start/Programs>Administrative Tools>Event Viewer**.
   **Result:** The Event Viewer window appears. From this window you can view all of your ePro operating system errors.

2. From the Log menu, click **Application**.
   **Result:** The *Application Log* window appears. From this window you can view all of your application errors, such as any communication errors that occurred between the ePro unit and a PLC, etc.

Using the NT Event Log to Log Communication Errors

PanelMate ePro and PC Pro can be configured to use the Windows Event Log (Application Event type) and Event Viewer to log and view PanelMate startup and communication errors. The internal scratchpad variable used to enable logging to the Windows Event Log is `eventlog`. When the value of `eventlog` is set to one, all communication errors will be logged. When set to zero, no logging will occur. In addition to logging communication errors, PanelMate will also write a success audit event into the log whenever it is started up and shut down and will log any errors such as address parsing errors while PanelMate is starting up.

To configure writing to the event log, place the following message somewhere in the Message Library:

```
@[sp,eventlog;U32;1]
```

This procedure will initialize the variable as an unsigned 32-type with an initial value of one. It is important that the event log be configured to overwrite/delete old events from the log when the log becomes full. PanelMate ePro units are already configured this way but a PanelMate PC Pro unit may not be configured properly. To configure the event log to overwrite/delete old events in Windows NT, start the event viewer using **Start>Programs>Administrative Tools (Common) – Event Viewer**, choose the application log with the menu selection **Log-Application** and modify the settings with the menu selection **Log-Log Settings**. In the *Event Log Settings* window, choose the **Change Settings for Application Log**. You can choose to increase the **Maximum Log Size** setting from the default 512 KB if desirable, then select the **Event Log Wrapping** setting to overwrite the **Overwrite Events as Needed** setting. This configuration ensures that the user will not encounter an **Event Log Full** error while online.

For Windows 2000 applications this setup is done by opening Control Panel (**Start>Settings>Control Panel**), opening the **Event Viewer** from Control Panel, then right-clicking the *Application Log* icon in the left window pane and choosing **Properties**.
Replacing the Fuse

There is one user replaceable fuse in your PanelMate ePro unit and it is located on the side of your unit, directly above the DC power connector.

To replace the fuse

1. Disconnect power from your PanelMate ePro unit.
2. Use a Phillips screwdriver to carefully lift out the fuse holder in which the fuse is installed.
3. Pull the fuse out of the fuse holder and replace it with a ¼ x 1 ¼ 2AG 229 Series Slo Blo fuse, 3 ½ Amp.

Calibrating the Touchscreen

Confirm that the ePro’s Protect Mode status is in Normal Mode before calibrating the touchscreen. If the unit is in Protect Mode, the new calibration values will NOT be saved but will be in effect only until the unit is restarted. On power-up the ePro will revert back to the saved calibration settings.

Integrated (Non-Blind Node) Units

The PanelMate ePro’s TouchKO touchscreen driver loads automatically at bootup. A Calibrate Touchscreen icon is placed in the system tray in the lower-right corner (by the clock) of the display.

If for some reason you find it necessary to re-calibrate the touchscreen, you can do so by touching the icon, or by using a mouse to click the icon. Doing so launches the TouchKO Touchscreen Driver dialog box, so that you can touch or click the CALIBRATE button to start the calibration process.

Once you start the calibration process, a purple crosshairs icon appears on a gray background in the lower-left corner of the display. While in your normal operating position, touch or click the crosshairs in the middle of the icon. The icon moves to the upper-right corner of the display. Touch or click the icon again, and it moves to its final destination in the lower-right corner of the display.

Once you have accurately touched or clicked the icon for the third time, touch or click the END CALIBRATION button to return you to the TouchKO Touchscreen Driver dialog box. Touch or click the OK button to permanently save the new calibration, or the Cancel button to return to the previously saved settings.
Blind Node Units

The PanelMate ePro’s Elo touchscreen driver loads automatically at bootup.

If for some reason you find it necessary to re-calibrate the touchscreen, you can do so by selecting Start>Settings>Control Panel and then selecting the Elo Touchscreen icon. Doing so launches the Elo Touchscreen Properties dialog box. Select Calibrate in the General tab to start the calibration process.

Note: On the General tab, the Touchscreen Port should be set to COM 1.

Once you start the calibration process, a crosshair on a red and white target appears in the upper-left corner of the display. While in your normal operating position, touch the crosshairs again, and the crosshairs will move to the upper-right corner of the display. After touching the upper-right crosshairs, a Check Calibration dialog box will appear, informing you that you have 30 seconds to confirm the calibration. Touch points on the screen to confirm the arrow cursor is tracking as desired and then select YES (if the calibration does not look correct then select NO and re-calibrate the screen until you are satisfied). Once you select YES, you are returned to the Elo Touchscreen Properties dialog box. Close the Elo Touchscreen Properties dialog box by clicking the OK button. The calibration settings will be saved at this time.

Close the Control Panel window by touching or clicking the exit shortcut button (X) at the top of the window.

Calibrating the TouchPanel

Before starting the calibration process, confirm that the ePro’s Protect Mode status is in Normal Mode. If the unit is in Protect Mode the new calibration values will NOT be saved but will be in effect until the unit is restarted. On power-up the ePro will revert back to the saved calibration settings (see Chapter 4 for more information about Protect Mode).

The TouchPanel is defined as any of the touch areas on a TouchPanel unit. If touches are not returning correct values then it may be necessary to recalibrate the TouchPanel.

Integrated (Non-Blind Node) Units

The PanelMate ePro’s TouchPanel driver loads automatically at bootup. A TouchPanel Driver icon is placed in the system tray in the lower-right corner (by the clock) of the display.

To start the calibration process, select the icon in the system tray. Doing so launches the TouchKO Touchscreen Driver dialog box. Next select the Calibrate All button.

If Matrix Mode is ON during the calibration process, you will need a mouse connected to the unit. The mouse cursor can only be moved by using the mouse. If Matrix Mode is OFF, a mouse is optional and the mouse cursor can be moved by using the Touchpad Area or the mouse (see Chapter 5 for details on Matrix Mode).

During the calibration process, you will be calibrating four areas (see diagram below).

1. Cancel, Right Mouse, Left Mouse Area
2. Touchpad Area
3. Numeric Keypad Area
4. Control Buttons Area
During the calibration process you will see two selection buttons on the right side of the screen, **Retry** and **End Calibration**, along with a readout window. At any time you can select the **Retry** button to re-select the calibration points for the section in process or you can select the **End Calibration** button to move to the next step of the process.

Follow the prompts on the display to complete the calibration process.

If the **End Calibration** button is selected before the four areas have been calibrated, a calibration failure error message will be displayed and no new calibration values will be saved.

When testing the Right Mouse key during the first calibration step, a drop-down menu will appear instead of the **R** character if the ePro has Matrix Mode OFF and the mouse cursor is in the readout window. To see the **R**, move the mouse cursor out of the readout window.

When done calibrating, select the **Exit** button in the **TouchKO Touchscreen Driver** dialog box to close the window.

**Using a Mouse in Run Mode**

When you are ready to go online, disconnect the mouse. Conducted and radiated electrical noise that is often found in industrial environments may result in the mouse malfunctioning and generating erroneous signals. It is recommended that the operator use the ePro touchscreen or TouchPanel as the primary user input device.
If the operator is only using the touchscreen on an ePro touchscreen unit, you can also disable the mouse. To do this, complete the following steps. It is not recommended that the mouse be disabled on ePro TouchPanel units.

1. Click **Start>Settings>Control Panel**.
   - **Result:** The Control Panel window appears.
2. Double-click the **Devices** icon.
   - **Result:** The Devices window appears.
3. Scroll down the **Device** list, click **Mouse Class Driver**
4. Click the **Startup** button.
   - **Result:** The Device window appears.
5. From the **Startup Type** list, click the **Disabled radio** button.
6. Click the **OK** button.

**Notes:**
- This action also prevents mouse errors from being logged in the Windows Event Log when no mouse is present.
- If a mouse is required for future use, the mouse setting needs to be changed from **Disabled** to **System**.

**Placing the PanelMate ePro In Protect Mode**

Before you place the ePro unit in full-time online operation, you should place it into Protect mode to disable unauthorized write operations to the **C:|** partition and to ensure system online reliability.

See Chapter 4 for more information on placing your ePro unit into Protect mode.
This chapter describes PanelMate ePro hardware installation. The following topics are discussed:

- Enclosure selection
- Communication cable selection, shielding, grounding and termination
- Cable segregation and placement
- Cutout templates and unit dimensions
Enclosure Selection

Enclosure Rating
The front panels of PanelMate ePro units provide a Type 4, 4X or Type 12 rating when mounted in a correspondingly rated enclosure. Make sure the enclosure that you choose meets or exceeds your application’s Type rating requirement.

Enclosure Construction
Cutler-Hammer recommends an enclosure constructed of cold rolled steel. This type of enclosure helps guard your unit against electromagnetic interference, and provides proper structural support and good heat dissipation.

Enclosure Sizing and Unit Positioning
Careful enclosure sizing is important for proper heat dissipation and easy installation and maintenance. For efficient convection cooling, free space is needed around the ePro unit and the unit should be mounted in a vertical position. Convection cooling draws a vertical column of air upward over internal circuitry through the vents in the unit. In all installations, the cooling air must not exceed the maximum specified ambient temperature. This determination must be made for the maximum expected plant temperature (maximum temperature of the air surrounding the enclosure.)

- Maintain recommended free space above and below the ePro unit (see the table on next page).
- Avoid mounting other heat-generating equipment near the ePro unit. If no other location is available, mount the equipment beside or behind the ePro unit. If side/rear space is not available, it is preferable to mount the other equipment above rather than below the ePro unit. Be sure to maintain the recommended free space area between the ePro unit and the other equipment.

Leave room for easy access to circuit boards, wiring and cable connections, and for regular maintenance.
**Recommended Free Space and Maximum Operating Temperature Table**

The table below provides the recommended free space and maximum operating temperature figures for your ePro unit.

**Note:** The free space area is the space between the ePro unit’s electronics and the top or bottom of the enclosure.

<table>
<thead>
<tr>
<th>Maximum Operating Ambient Temperature</th>
<th>Maximum Unit Heat Output</th>
<th>Recommended Free Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>50°C</td>
<td>34W</td>
<td>4‰ minimum</td>
</tr>
</tbody>
</table>

If the inside temperature of the enclosure is above the PanelMate ePro unit’s recommended range, you must use filtered fans, heat exchangers, or air conditioners to lower the temperature. Because hot air rises to the top of an enclosure, the temperature inside can vary greatly from bottom to top. A fan can be used to circulate air within the enclosure to maintain a more uniform temperature. Make sure the magnetic properties of the equipment used to cool the enclosure do not interfere with your PanelMate ePro unit’s operation. CRT monitors are especially susceptible to magnetic fields.

**Note:** If an air-purged enclosure is used, it is recommended that the inside/outside pressure differential not exceed 0.5 PSI.

The following sizing table is offered as an aid in the selection of enclosures to be used with the PanelMate ePro unit. Cutler-Hammer offers no guarantee or warranty to the specific applicability of this table as actual conditions may vary and methods of the use of our products are beyond our control. For specific information about enclosure selection and cooling methods, contact your enclosure vendor.

**Note:** Refer to the ePro Cutout Template and Unit Dimensions section for more information.

<table>
<thead>
<tr>
<th>Enclosure Size</th>
<th>Average Internal Temperature Rise at Maximum Heat Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>16 x 16 x 8</td>
<td>13°C</td>
</tr>
<tr>
<td>20 x 16 x 8</td>
<td>11°C</td>
</tr>
<tr>
<td>20 x 16 x 10</td>
<td>9.5°C</td>
</tr>
<tr>
<td>20 x 20 x 10</td>
<td>7.5°C</td>
</tr>
<tr>
<td>24 x 20 x 10</td>
<td>6°C</td>
</tr>
<tr>
<td>24 x 24 x 10</td>
<td>6°C</td>
</tr>
</tbody>
</table>

**Notes:**

- This table is based on the following assumptions:
  - Enclosure is fabricated from cold rolled steel
  - All sides of the enclosure are uninsulated (free standing)
  - Recommended minimum clearance between the PanelMate unit and the top and bottom of the enclosure
No other heat-generating equipment is installed in the enclosure.

The temperature rise shown represents the temperature rise in the enclosure above the outside temperature. For example: if the temperature outside the enclosure is 35°C and the temperature rise in the enclosure is 10°C, then the average temperature inside the enclosure will be 45°C.

**Communication Cable Selection, Shielding, Grounding and Termination**

A variety of communication interface options are available for the ePro unit. These options include:

- RS232 communications (COM2)
- High speed network communications

*Note:* External converters are required to communicate with RS422 and RS485.

Cutler-Hammer does not recommend any specific communications option. Your choice should be based on the requirements of your total control system. The communications option that you choose determines the precautions that you need to take when installing and connecting your PanelMate ePro unit.

For easy reference, this section contains a summary of seven popular communication interface options. Each summary provides specific recommendations, guidelines and installation tips.

*Note:* Low signal level conductors (Category 2) have a low tolerance for induced electrical noise. Electrical noise can cause a wide range of communications problems resulting in slow or error-prone PanelMate ePro operation. Follow all of the installation recommendations for the communication option that you choose. Also, follow good wiring placement practices as outlined in the **Cable Segregation and Placement** section.

### RS232 Communications (COM2)

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type/Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 50 feet</td>
<td>24 gauge, shielded pair</td>
</tr>
</tbody>
</table>

#### RS232 Grounding Recommendations

Grounding of the communication cable shield at both ends provides the most immunity to high frequency electrical interference. However, the introduction of low frequency interference by high ground currents in the shield may require grounding only one end. Should this approach result in unacceptable high-frequency interference, then an RS422 interface should be considered. For RS232 communications, the maximum rated input voltage at the PanelMate unit's serial port is –30 to +30V.

#### RS232 Shielding Recommendations

**Application:** Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. An unshielded line is not recommended because the unshielded connectors may act as an antenna resulting in radiated emissions that may exceed the CE required...
limit. Additionally, shielded cable provides greater ESD protection. The shield should be connected directly to the chassis of the interconnected units at both ends. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

**Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low Frequency Ground Differential Voltage Between Connected Units**

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. The shield should be connected directly to the chassis of one of the interconnected units (one end only). Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

**Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low Frequency Ground Differential Voltage Between Connected Units**

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. The shield should be connected directly to the chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad capacitor at the other end to the chassis of the second unit. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Attaching the capacitor at the ac-coupled end requires some ingenuity to achieve a secure connection at both the shield and chassis while keeping the capacitor lead length as short as possible.

**RS422 Communications Using an External RS232 to RS422 Converter**

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type /Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Up to 4000 feet</td>
<td>22 gauge, shielded pair</td>
</tr>
<tr>
<td>• Up to 2000 feet</td>
<td></td>
</tr>
<tr>
<td>for RS422</td>
<td></td>
</tr>
<tr>
<td>connected to A-B Channel 0</td>
<td></td>
</tr>
</tbody>
</table>
RS422 Grounding Recommendations

This balanced interface operates with common mode DC or peak AC voltages differentials of –7 to +7 volts between grounds at each end of the cable. In cases where the common mode voltage approaches either extreme, the system may operate properly when the shield is grounded at only one end of the cable. However, this arrangement makes the system susceptible to high frequency interference. If the systems do not operate properly due to high frequency interference and grounding the cable shield at both ends is ineffective, then total isolation must be considered or ground potentials in your plant eliminated.

RS422 Shielding Recommendations

Application: Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. An unshielded line is not recommended because the unshielded connectors may act as an antenna resulting in radiated emissions that may exceed the CE required limit. Additionally, shielded cable provides greater ESD protection. The shield should be connected directly to the chassis of the interconnected units at both ends. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. The shield should be connected directly to the chassis of one of the interconnected units (one end only). Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. The shield should be connected directly to the chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad capacitor at the other end to the chassis of the second unit. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Attaching the capacitor at the ac-coupled end will require some ingenuity to achieve a secure connection at both the shield and chassis while keeping the capacitor lead length as short as possible.
RS485 Multi-Drop Communications Using an External RS232 to RS485 Converter

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type /Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Up to 4000 feet</td>
<td>22 gauge, shielded pair</td>
</tr>
<tr>
<td>• Up to 2000 feet for RS485 connected to A-B Channel 0</td>
<td></td>
</tr>
</tbody>
</table>

This network is an extension of RS422 and is used for the distribution of data between multiple system components and peripherals over distances up to 4000 feet. This system will tolerate common mode voltage differentials from –7 to +12 volts. For more information refer to the EIA RS485 Standard.

**RS485 Shielding Recommendations**

**Application: Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT Levels of Low Frequency Ground Differential Voltage Between Connected Units**

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. An unshielded line is not recommended because the unshielded connectors may act as an antenna resulting in radiated emissions that may exceed the CE required limit. Additionally, shielded cable provides greater ESD protection. The shield should be connected directly to the chassis of the interconnected units at both ends. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

**Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low Frequency Ground Differential Voltage Between Connected Units**

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. The shield should be connected directly to the chassis of one of the interconnected units (one end only). Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

**Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low Frequency Ground Differential Voltage Between Connected Units**

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. The shield should be connected directly to the chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad capacitor at the other end to the chassis of the second unit. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Attaching the capacitor at the ac-coupled end will require some ingenuity to achieve a secure connection at both the shield and chassis while keeping the capacitor lead length as short as possible.
Allen-Bradley DH485 Communications

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type/Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 4000 feet</td>
<td>Belden 9842 cable</td>
</tr>
</tbody>
</table>

**Note:** In order to communicate to an AB SLC-500 on a DH485 network, the ePro needs to access the DH485 network using serial communications (COM2) with an AB KFB module. Refer to your Allen-Bradley Cable Installation manual for detailed information.

Allen-Bradley Data Highway/Data Highway Plus Communications

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type/Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 10,000 feet at 57.6K baud. Shorter lengths at higher baud rates</td>
<td>Belden 9463 “blue hose” twin axial cable</td>
</tr>
</tbody>
</table>

Data Highway and Data Highway Plus are proprietary communication networks of Allen-Bradley. Generally, the structure and components of the two networks are the same, but there are differences in communications protocols. Refer to your Allen-Bradley Cable Installation Manual for detailed information.

The following tips are useful when installing a PanelMate on A-B Data Highway and Data Highway Plus communication networks:

**Tip #1:** Verify that the network is terminated. Both ends of an A-B Data Highway/Data Highway Plus network must contain termination resistors. Resistor value is determined by the network baud rate. The resistor value must be the same at both ends of the network:

- 57.6 K, 115.2K: 150 or 82.5 Ohm
- 230.4K: 82.5 Ohm

**Tip #2:** The minimum cable length is 20 feet between any two nodes.

**Tip #3:** On Data Highway Plus networks, daisy chained networks are preferred, but trunk line/drop line is acceptable. Star or tree configurations are not acceptable.

**Modicon Modbus Plus Communications**

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type /Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 7500 feet at 38.4K baud. Shorter lengths at higher baud rates</td>
<td>Refer to your Modicon Modbus Plus Network Planning and Installation Guide</td>
</tr>
</tbody>
</table>

This proprietary communications network consists of twisted pair shielded cable extending up to 1500 feet with up to 32 nodes. For detailed installation instructions refer to your Modicon Modbus Plus Network Planning and Installation Guide.
The following tips are useful when installing a PanelMate on Modicon Modbus Plus communication networks:

**Tip #1:** Drop/drop line is the only acceptable network configuration. Star or tree configurations are NOT acceptable.

**Tip #2:** A drop cable is used to connect the PanelMate unit to the trunk line tap. The drop cable is equipped with a ground lug that must be connected to the PanelMate unit's panel ground.

**Tip #3:** The minimum cable length between nodes must be at least 10 feet.

### PROFIBUS DP Communications

<table>
<thead>
<tr>
<th>Recommended Distance</th>
<th>Recommended Cable Type /Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to 3278 feet at 93.7K baud</td>
<td>22 gauge, shielded pair</td>
</tr>
</tbody>
</table>

PROFIBUS DP is based on RS485 network technology. A PROFIBUS DP network may have up to 126 nodes, but maximum length of the network is determined by baud rate.

### PROFIBUS DP Shielding Recommendations

A good quality shielded cable consisting of twisted pairs for the required communication wires and logic common is recommended. An unshielded line is not recommended because the unshielded connectors may act as an antenna resulting in radiated emissions that may exceed the CE required limit. Additionally, shielded cable provides greater ESD protection. The shield should be connected directly to the chassis of the interconnected units at both ends. The connector housing should contact the cable shield uniformly around the entire 360-degree periphery of the housing cable entry opening. Never connect the shield by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be terminated as closely as possible to the connector to minimize the pigtail length.

### Using PanelMate on a PROFIBUS DP Network

The following tips are useful when installing a PanelMate on a PROFIBUS DP communication network:

**Tip #1:** The PROFIBUS network must be terminated at both ends of every segment. The termination must be powered at all times.

**Tip #2:** As the PROFIBUS DP network allows daisy-chained connections, wiring for Signal A and Signal B must remain consistent throughout the segment. It is suggested that the green wire is used for Signal A and the red wire is used for Signal B.
Cable Segregation and Placement

Cable Segregation

The low power cabling used for PLC and PC-based control systems is very susceptible to electrical noise generated by high power conductors. Even when protected by conduit, noise can interfere with your communication lines and networks. Therefore it is important to segregate conductors according to their type.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category 1</td>
<td><strong>High Power Conductors</strong></td>
<td>• AC power lines&lt;br&gt;• High power digital AC and DC lines&lt;br&gt;• Typically these conductors are used to connect hard-contact switches, relays, solenoids, motors, generators and arc welders.</td>
</tr>
<tr>
<td></td>
<td>These conductors can cause electrical noise in Category 2 conductors when in close proximity.&lt;br&gt;Are more tolerant of electrical noise than Category 2.</td>
<td>Reference: NEC article 725 class 1&lt;br&gt;Reference: IEEE level 3 and 4</td>
</tr>
<tr>
<td></td>
<td>Reference: NEC article 725 class 2, class 3&lt;br&gt;Reference: IEEE level 1 and level 2</td>
<td></td>
</tr>
<tr>
<td>Category 2</td>
<td><strong>Low Signal Level Conductors</strong></td>
<td>• Communication cables—Ethernet, PLC networks, etc.&lt;br&gt;• Low power digital AC and DC I/O lines&lt;br&gt;• Typically these conductors are used to connect PLCs and related modules with PanelMate ePros</td>
</tr>
<tr>
<td></td>
<td>These conductors are less tolerant of electrical noise; however, they cause less noise in adjacent conductors.</td>
<td>Reference: NEC article 725 class 2, class 3&lt;br&gt;Reference: IEEE level 1 and level 2</td>
</tr>
</tbody>
</table>

Cable Placement

The following guidelines should be used when installing your communication cables:

- All Category 2 cables should be shielded and routed in a separate conduit or raceway from Category 1 cables
- Route Category 2 cables at least one foot from 120 VAC power lines
- Route Category 2 cables at least two feet from 240 VAC power lines
- Route Category 2 cables at least three feet from 480 VAC power lines
- Route Category 2 cables at least five feet from high voltage enclosures
• If a Category 2 cable must cross Category 1 cables, it should cross at a right angle
• If Category 2 cable is enclosed in metal conduit or a metal raceway, electrical continuity must be maintained along the entire length of the conduit/raceway installation, including entry into the enclosure

Potential Problem Areas

The following are potential problem areas that might be encountered when installing your communication cables:

• High and low power conductors routed in the same conduit or raceway
• Conduit with low power conductors routed in close parallel proximity to conduit containing high power conductors
• Cable or PanelMate unit located too close to devices generating high levels of magnetic or electrical interference
• Lack of continuous electrical continuity along the length of the conduit installation
Cautions:
- Care should be taken when tightening the nuts. The fasteners must be tightened enough to obtain a proper seal, but not over tightened to the point where the threads are stripped or the gasket is rendered useless. Always use a torque wrench when installing your PanelMate ePro unit.
- The reproduction process may distort this cutout template. Always check your dimensions prior to cutting your panel.

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services website.
7575T-8 and 7585T-8 Series Unit Dimensions

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- Allow cable clearance on both left and right side of unit.
- The unit dimensions are available (in .dwg format) on Advanced Technology Services website.
Cautions:
- Care should be taken when tightening the nuts. The fasteners must be tightened enough to obtain a proper seal, but not over tightened to the point where the threads are stripped or the gasket is rendered useless. Always use a torque wrench when installing your PanelMate ePro unit.
- The reproduction process may distort this cutout template. Always check your dimensions prior to cutting your panel.

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services website.
7585K-8 Series Unit Dimensions

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services website.
7585T-10 Series Cutout Template

Cautions:

- Care should be taken when tightening the nuts. The fasteners must be tightened enough to obtain a proper seal, but not over tightened to the point where the threads are stripped or the gasket is rendered useless. Always use a torque wrench when installing your PanelMate ePro unit.
- The reproduction process may distort this cutout template. Always check your dimensions prior to cutting your panel.

Notes:

- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advancd Technology Services website.
7585T-10 Series Unit Dimensions

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services website.
Cautions:
- Care should be taken when tightening the nuts. The fasteners must be tightened enough to obtain a proper seal, but not over tightened to the point where the threads are stripped or the gasket is rendered useless. Always use a torque wrench when installing your PanelMate ePro unit.
- The reproduction process may distort this cutout template. Always check your dimensions prior to cutting your panel.

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services website.
7585K-10 Series Unit Dimensions

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services website.
7500 Unit Dimensions

Notes:
- Dimensions are in inches. (Millimeter dimensions are in parentheses.)
- The cutout template is available (in .dwg format) on Advanced Technology Services' website.
Index

D
Data Format, 66
Deactivate, 63
Default Control Buttons, 51
Directory, 54
DiskonKey Device
  Connecting to ePro, 25
Display System/Configuration Information, 62
Document Viewer, 12
Downloading a Configuration (.pps File), 33

E
embedded NT (NTE), 11
Enclosure Construction, 90
Enclosure Rating, 90
Enclosure Selection, 90
Enclosure Sizing and Unit Positioning, 90
ePro Base Models, 11
ePro Event Viewer, 84
ePro Models, 11
ePro Technical Details, 13
ePro Troubleshooting, 83
ePro X1 Models, 12
ePro XE Models, 12
Errors During Run Mode, 69
ethernet, 11

F
First Time Power Up Process, 17

H
Headline Manager, 12
How to Bypass the Auto Logon Feature, 37
How to Disable the Auto Logon Feature, 36
How to Re-enable/Change the Auto Logon Feature, 36

I
Installing an Optional Interface Card, 20
Installing Software, 31
Installing Software and Downloading Configurations, 30
Installing Software Via an Ethernet Connection, 32
Installing Software Via an Iomega USB Device, 32
Installing Software Via an M-Systems DiskonKey Device, 32
Integrated (Non-Blind Node) Units, 85, 86
Interface Card Errors, 80
Iomega USB Device
  Connecting to ePro, 26

7
7500 Unit Dimensions, 108
7575T-8 and 7585T-8 Series Cutout Template, 100
7575T-8 and 7585T-8 Series Unit Dimensions, 101
7585-10 Series Cutout Template, 106
7585K-10 Series Unit Dimensions, 107
7585K-8 Series Cutout Template, 102
7585K-8 Series Unit Dimensions, 103
7585T-10 Series Cutout Template, 104
7585T-10 Series Unit Dimensions, 105

A
Acknowledging a Single Alarm, 58
Acknowledging Alarms Remotely, 58
Acknowledging All Alarms, 58
Alarm Summary Page, 57
Alarm Window, 50
Alarms, 56
Allen-Bradley Data Highway/Data Highway Plus
  Communications, 96
Application Kits, 12

B
Base Models, 11
Blind Node Units, 86

C
C/D Partitions, 30
Cable Placement, 98
Cable Segregation, 98
Cable Segregation and Placement, 98
Calibrating the TouchPanel, 86
Calibrating the Touchscreen, 85
Change Password A or Change Password B, 61
Change PLC Name, 64
Change PLC Ref, 64
Change Value, 63
Checking the Protect Mode/Normal Mode Status, 44
Checking User Configuration Compatibility, 82
Cleaning Mode, 62
Close PanelMate Application, 62
Closing the ePro Demo, 18
Communicating to a PLC or Controller, 19
Communication Cable Selection, Shielding, Grounding and Termination, 92
Communication Errors, 69
Conditional Visibility, 51
Connecting to the Serial Port (COM2), 19
Connecting to Your ePro Via the Ethernet, 22
Connecting Windows 98 PCs to an ePro, 27
Connecting Windows ME PC’s to an ePro, 30